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Preface

This document contains the setup and installation information for all supported 
RoamAbout DS PC Card drivers and utilities. 

Visit the www.enterasys.com/wireless web site for the latest upgrades and documentation.

Intended Audience

This document is intended for the wireless network manager. You should have a basic 
knowledge of Local Area Networks (LANs) and networking functions.

Organization

This document is organized as follows:

Section Description

Chapter 1 Provides setup and installation information for the Windows 
95 driver. 

Chapter 2 Provides setup and installation information for the Windows 
98 driver.

Chapter 3 Provides setup and installation information for the Windows 
2000 driver.

Chapter 4 Provides setup and installation information for the Windows 
Millennium driver. 

Chapter 5 Provides setup and installation information for the Windows 
NT driver. 

Chapter 6 Provides setup and installation information for the Windows 
CE driver.

Chapter 7 Provides setup and installation information for the Linux 
driver.
   ix

http:://www.enterasys.com/wireless


Associated Documents
Associated Documents 

The documentation, drivers, and utilities can also be downloaded from the RoamAbout 
Wireless web site.

Check the RoamAbout Wireless web site regularly for product upgrades.

http://www.enterasys.com/wireless 

Chapter 8 Provides setup and installation information for the MS-DOS 
or Microsoft Windows for Workgroups (usually referred to 
as Windows 3.1) system.

Chapter 9 Provides setup and installation information for Macintosh 
driver.

Appendix A Provides installation and use information for the 
RoamAbout Client Utility. 

Appendix B Provides installation and use information for the Work 
Station Update Utility (WSU).

Component Information Location

RoamAbout Access Point RoamAbout Access Point 2000 Hardware 
Installation Guide

RoamAbout Access Point 2000 Hardware 
Installation Quick Start

RoamAbout Access Point Manager RoamAbout 802.11 Wireless Networking Guide

RoamAbout 802.11 DS PC Card RoamAbout 802.11 PC Card Drivers and 
Utilities CD-ROM Kit 

RoamAbout 802.11 Drivers RoamAbout 802.11 PC Card Drivers and 
Utilities CD-ROM Kit

RoamAbout Client Utility RoamAbout 802.11 PC Card Drivers and 
Utilities CD-ROM Kit

RoamAbout Work Station Update RoamAbout 802.11 PC Card Drivers and 
Utilities CD-ROM Kit

Section Description
x  



Getting Help

ork
Getting Help

For additional support related to this device or document, contact Enterasys Networks 
using one of the following methods:

Before calling Enterasys Networks, please have the following information ready:

• Your Enterasys Networks service contract number 

• A description of the problem

• A description of any action(s) already taken to resolve the problem

• The serial and revision numbers of all involved Enterasys Networks products in the netw

• A description of your network environment (for example, layout, cable type)

• Network load and frame size at the time of trouble (if known)

• The device history (for example, have you returned the device before, is this a recurring 
problem)

• Any previous Return Material Authorization (RMA) numbers

RoamAbout Outdoor Solution RoamAbout Outdoor Antenna Site Preparation 
and Installation Guide

RoamAbout ISA Adapter Card RoamAbout ISA Adapter Installation

RoamAbout PCI Adapter Card RoamAbout PCI Adapter Installation

World Wide Web: http://www.enterasys.com/wireless

Phone:                  North America: (603) 332-9400
                              Europe: 353 61 701 910
                              Asia: +800 8827-2878

Internet mail:       support@enterasys.com

To send comments or suggestions concerning this document, contact the Enterasys 
Networks Technical Writing Department via the following email 
address:TechWriting@enterasys.com

Make sure to include the document Part Number in the email message.

Component Information Location
 xi





Chapter 1

Windows 95 Driver

This chapter provides setup and installation information for the Windows 95 NDIS 3 
miniport driver Version 6.25 to support the RoamAbout DS PC card in an 802.11 wireless 
LAN. This driver works with various versions of the RoamAbout PC Card. However, 
earlier versions of the RoamAbout PC Card do not support WEP Encryption and cannot be 
upgraded to support encryption. The Determining if your Card Supports Encryption 
provides the instructions to determine whether or not your PC Card supports encryption. 

To install the RoamAbout driver, you should have a working knowledge of Microsoft 
Windows operations and a working knowledge of installing network adapter cards and 
network client software.

In This Chapter

System Requirements

Depending on your system configuration, your installation procedure may 
be slightly different from the procedures listed.

Section Page

System Requirements 1-1

Determining if your Card Supports Encryption 1-2

Upgrading the Driver 1-2

New Installations 1-4

Reinstallation 1-6

Installation Verification 1-9

Driver Configuration 1-9

NOTE
   1-1



Determining if your Card Supports Encryption
• Operating System: Microsoft Windows 95 

• Disk Space: 170 KB 

• 16 MB RAM 

Determining if your Card Supports Encryption
To determine if the RoamAbout PC Card supports encryption, perform the following:

• Check for a sticker on the back of the PC Card that states support for 40-bit or 128-bit 
encryption. 

or

• Run the Client Utility (if already installed). Click on the Help menu and select Version 
Info from the drop-down list. Check the Card field for WEP encryption allowed. If it 
does not list WEP encryption allowed, your card does not support this feature.

Upgrading the Driver
Upgrading driver versions prior to 6.25 requires deleting the old driver files from your hard 
disk before installing the new driver. 

When you select the Remove Driver option from the Network Control Panel, the operating 
system disables the driver but does not delete the driver from your hard disk. Therefore, 
when you upgrade a driver. Windows recognizes your RoamAbout PC Card as hardware 
that had been installed before and attempts to reinstall the old driver. 

To upgrade your RoamAbout driver, follow the procedure in Removing the RoamAbout 
Miniport Driver Version prior to 6.25. Then, follow the procedure in Deleting the 
RoamAbout Driver Files before you install the new driver.
1-2  



Upgrading the Driver
Removing the RoamAbout Miniport Driver Version prior to 6.25
If you have a RoamAbout Miniport driver installed prior to Version 6.25, you need to 
perform extra steps. Check the driver version number using your installed RoamAbout 
Client Utility before performing this procedure. 

1) Click on the PC Card (PCMCIA) status icon and select Stop RoamAbout 
802.11 DS (Cabletron). 

A message appears stating that you may safely remove this device. 

2) Click OK. 

3) Remove the PC Card from the PC Card slot.

4) Close all open applications.

5) From the Task bar on the Windows desktop, click Start then select 
Settings-->Control Panel.

6) In the Control Panel window, double-click on the Network icon.

7) Select the RoamAbout PC Card and click on the Remove button. Then, 
click OK.

The Windows operating system disables the Miniport driver and updates the 
driver configuration files. 

8) Do NOT restart the computer. Instead, perform the procedure in Deleting the 
RoamAbout Driver Files in this document. 

Deleting the RoamAbout Driver Files
The procedure to remove the RoamAbout Miniport Driver files from the hard disk is similar 
for all Windows operating systems.

If not already done, remove the RoamAbout driver as described in the Removing the 
RoamAbout Miniport Driver Version prior to 6.25 section. Otherwise, the Windows 
Registry is not "cleaned", which can lead to complications when installing the RoamAbout 
driver in the future.

1) Open the Windows Explorer.

2) In the Explorer menu, click on View and select Options.

3) From the View tab, select Show all files and clear the Hide MS-DOS file 
extensions check box.

4) Click on the Apply button to return to the Explorer window.
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New Installations
5) In Explorer, open the Windows operating system folder: 

c:\windows\system 

6) Delete the following RoamAbout driver files:

wvlan41.sys

wvlanuif.vxd

wv41inst.dll (if present)

wvlan41.hlp 

wvlan41.cnt 

wvlan41.fts (if present)

wvlan41.gid (if present)

rmabt41.hlp (if present)

rmabt41.cnt (if present)

rmabt41.gid (if present)

7) Open c:\windows\inf and delete the rmabt41.inf file.

8) Close the Windows Explorer and restart your computer.

9) If deleting the driver files was part of an upgrade procedure, install the new 
driver as described in the New Installations section of this document.

New Installations
The computer must be configured with the same network protocols used by the other 
network devices. The commonly used protocols include TCP/IP, IPX/SPX, and NetBEUI. 
Refer to the documentation provided by the network protocol software or operating system.

To install the RoamAbout Windows 95 driver, perform the following steps: 

1) Run the 50comupd.exe file before you install the Windows 95 driver. Browse 
to the CD-ROM directory \Drivers\Win95\Update95. Or, if you downloaded 
the driver from the RoamAbout Wireless web site, in the directory you 
specified during the extraction of the downloaded file. 

2) Follow the online instructions.

3) Reboot the computer.

4) Insert the RoamAbout PC Card.
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New Installations
5) Perform one of the following:

• If you see the New Hardware Found dialog, select Driver from disk 
provided by Hardware Manufacturer then click OK. Windows 95 starts 
the Add New Hardware wizard, step through the wizard.

•  If you see the Select Network Adapter window, select the RoamAbout 
PC Card then click Have Disk. 

•  If you don’t see any of the above, perform the following steps to manually 
install the driver: 

a)Click on Start-->Settings-->Control Panel.

b)Click on the System icon.

c)Select the Device Manager tab.

d)Select Network Adapters-->RoamAbout 802.11 DS.

e)Select Properties.

f)Select the Driver tab.

g)Click on Update Driver.

The system displays Do you want Windows to search for the driver?

h)Click on No, select driver from list and click on Next.

i)Click on Have Disk.

j)Browse to the directory containing the driver.

k)Select the wlrbt41.inf file and click on OK.

l)Click on OK twice.

m)Perform Steps 6 through 10 below.

n)Click on Finish.

When prompted, browse to the CD-ROM directory \Drivers\Win95. Or, if 
you downloaded the driver from the RoamAbout Wireless web site, in the 
directory you specified during the extraction of the downloaded file.
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Reinstallation
6) If you are prompted for operating system files, insert the operating system 
media. 

After the driver is installed, the Add/Edit Configuration Profile window 
appears.

7) Select a profile and edit the profile with your network configuration 
parameters, such as the Wireless Network Name.

If you are joining a wireless network with Access Points, enter values specific 
to the network such as the wireless network name. Press <F1> while in a 
properties window for information, or refer to the RoamAbout 802.11 
Wireless Networking Guide.

8) Click OK. 

9) Close the window when you complete the configuration.

10) Reboot the computer. 

Reinstallation
If this is a reinstallation of the 6.25 driver, perform the following steps: 

1) Click on the PC Card (PCMCIA) status icon and select Stop RoamAbout 
802.11 DS (Cabletron). 

A message appears stating that you may safely remove this device. 

2) Click OK. 

3) Run the 50comupd.exe file before you install the Windows 95 driver. Browse 
to the CD-ROM directory \Drivers\Win95\Update95. Or, if you 
downloaded the driver from the RoamAbout Wireless web site, in the 
directory you specified during the extraction of the downloaded file.

4) Follow the online instructions.

5) Reboot the computer.

6) Insert the RoamAbout PC Card.

If you encounter problems during the installation procedure you must 
uninstall the RoamAbout Driver before reinstallation. Go to the New 
Installations section.

If you receive a message stating that the Client Utility is not installed, 
complete the driver installation. Then, refer to Appendix A for the 
instructions to install the Client Utility.
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Reinstallation
7) Perform one of the following:

(When prompted, browse to the CD-ROM directory, \Drivers\Win95. Or, if 
you downloaded the files from the RoamAbout Wireless web site, in the 
directory where you downloaded the files.)

•  If you see the New Hardware Found dialog, select Driver from disk 
provided by Hardware Manufacturer then click OK. 

•  If the Add New Hardware Wizard starts dialog, step through the wizard.

•  If you see the Select Network Adapter window, select the RoamAbout 
PC Card then click Have Disk. 

•  If you don’t see any of the above, perform the following steps to manually 
install the driver: 

a)Click on Start-->Settings-->Control Panel.

b)Click on the System icon.

c)Select the Device Manager tab.

d)Select Network Adapters-->RoamAbout 802.11 DS.

e)Select Properties.

f)Select the Driver tab.

g)Click on Update Driver.

The system displays "Do you want Windows to search for the 
driver? "

h)Click on No, select driver from list and click on Next.

i)Click on Have Disk.

j)Browse to the directory containing the driver.

k)Select the wlrbt41.inf file and click on OK.

l)Click on OK twice.
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Reinstallation
m)Perform Steps 8 through 11 below.

n)Click on Finish.

8) If you are prompted for operating system files, insert the operating system 
media. 

During the driver installation, the Add/Edit Configuration Profile window 
appears.

9) Select a profile and edit the profile with your network configuration 
parameters, such as the Wireless Network Name.

If you are joining a wireless network with Access Points, enter values specific 
to the network such as the wireless network name. Press <F1> while in a 
properties window for information, or refer to the RoamAbout 802.11 
Wireless Networking Guide.

10) Click OK. 

11) Close the window when you complete the configuration. 

 If you receive a message indicating that the Client Utility is not installed, 
complete the installation. Then, refer to Appendix A to install the Client 
Utility.

If you encounter problems during the installation procedure you must 
uninstall the RoamAbout Driver before reinstallation.

If you receive a message stating that the Client Utility is not installed, 
complete the installation. Then, refer to Appendix A to install the Client 
Utility.

NOTE
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Installation Verification
Installation Verification
To verify the RoamAbout PC Card Driver installation, perform the following steps: 

1) Install the RoamAbout Client Utility (see Appendix A)..

2) To start the Client Utility, perform the following: 

Click on the Client Utility icon located on the System Tray of your Windows 
Task bar. 

or

From the Windows Task bar, click Start, then select 
Programs-->RoamAbout-->Client Utility.

3) Click on the Help menu and select Version Info from the drop-down list.

Driver Configuration
To view or modify the driver configuration parameters, perform the following steps:

1) Open the Control Panel.

2) Double-click on the Network icon.

3) Double-click on the RoamAbout adapter line. Refer to the online help for 
more information.

Previous versions of the Client Utility do not support the new driver, 
therefore you must uninstall the previous version and install the new 
version before you configure the new driver.
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Chapter 2

Windows 98 Driver

This chapter provides setup and installation information for the Windows 98 NDIS 5 
miniport driver Version 6.25 to support the RoamAbout DS PC card in an 802.11 wireless 
LAN. 

This driver works with various versions of the RoamAbout PC Card. However, earlier 
versions of the RoamAbout PC Card do not support WEP Encryption and cannot be 
upgraded to support encryption. The Determining if your Card Supports Encryption 
section provides the instructions to determine whether or not your PC Card supports 
encryption.

To install the RoamAbout driver, you should have a working knowledge of Microsoft 
Windows operations and a working knowledge of installing network adapter cards and 
network client software.

In This Chapter

Depending on your system configuration, your installation procedure may 
be slightly different from the procedures listed.
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System Requirements
System Requirements

• Operating System: Microsoft Windows 98 

• Disk Space: 170 KB 

• 16 MB RAM 

Determining if your Card Supports Encryption
To determine if the RoamAbout PC Card supports encryption, perform the following:

• Check for a sticker on the back of the PC Card that states support for 40-bit or 128-bit 
encryption. 

or

• Run the Client Utility (if already installed). Click on the Help menu and select Version 
Info from the drop-down list. Check the Card field for WEP encryption allowed. If it 
does not list WEP encryption allowed, your card does not support this feature. 

New Installations

The computer must be configured with the same network protocols used by the other 
network devices. The commonly used protocols include TCP/IP, IPX/SPX, and NetBEUI. 
Refer to the documentation provided by the network protocol software or operating system.

To install the RoamAbout Windows 98 driver, perform the following steps: 

1) Insert the RoamAbout PC Card.

Windows 98 starts the Add New Hardware Wizard.

2) Click on Next.

3) Select Search for the best driver (Recommended).

4) Click on Next.

5) Deselect Floppy disk drives and CD-ROM drive and select Specify a 
location.
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New Installations
6) Enter the path of the driver. Enter the path of the driver. For example, the 
\Drivers\Win98 directory on the CD-ROM. Or, if you downloaded the driver 
from the RoamAbout Wireless web site, in the directory you specified during 
the extraction of the downloaded file.

7) Click on Next.

8) If you are prompted for operating system files, insert the operating system 
media. 

During the driver installation, the system displays the RoamAbout properties 
Add/Edit Configuration Profile window.

9) Select the profile and edit the profile with your network configuration 
parameters, such as the Wireless Network Name. 

If you are joining a wireless network with Access Points, enter values specific 
to the network such as the wireless network name. Press <F1> while in a 
properties window for information, or refer to the RoamAbout 802.11 
Wireless Networking Guide.

10) Click Finish.

11) Restart the computer. 

If you encounter problems during the installation procedure you must 
uninstall the RoamAbout Driver before reinstallation. Go to the 
Reinstallation or Upgrade section of this document.

If you receive a message stating that the Client Utility is not installed, 
complete the installation. Then, go to Appendix A for the in instructions to 
install the Client Utility.
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Reinstallation
Reinstallation
If this is an reinstallation, perform the following steps: 

1) Open the Control Panel and click on the System icon.

2) Click on the Device Manager tab.

3) Click on the Network Adapters icon.

4) Select RoamAbout 802.11 DS.

5) Click on Properties.

6) Click on the Driver tab.

7) Click on Update Driver to start the Update Driver Wizard.

8) Click on Next.

9) Select Search for a better driver than the one your device is using now 
(Recommended).

10) Deselect Floppy disk drives and CD-ROM drive and select Specify a 
location.

11) Enter the path of the driver. Enter the path of the driver. For example, the 
\Drivers\Win98 directory on the CD-ROM. Or, if you downloaded the driver 
from the RoamAbout Wireless web site, in the directory you specified during 
the extraction of the downloaded file.

12) Click on Next.

The Update Driver Wizard displays the message, "What would you like to 
install?"

13) Select The Updated Driver (Recommended).

RoamAbout 802.11 DS (Cabletron) is shown.

14) Click on Next. 

The location of the driver is shown.

15) If you are prompted for operating system files, insert the operating system 
media
During the driver installation, the system displays the RoamAbout properties 
Add/Edit Configuration Profile window.
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Installation Verification
16) Select the profile and edit the profile with your network configuration 
parameters, such as the Wireless Network Name. 

If you are joining a wireless network with Access Points, enter values specific 
to the network such as the wireless network name. Press <F1> while in a 
properties window for information, or refer to the RoamAbout 802.11 
Wireless Networking Guide.

17) Click Finish.

18) Restart the computer.

Installation Verification
To verify the RoamAbout PC Card Driver installation, perform the following steps: 

1) Install the RoamAbout Client Utility (see Appendix A).

2) To start the Client Utility, perform the following: 

Click on the Client Utility icon located on the System Tray of your Windows 
Task bar. 

or

From the Windows Task bar, click Start, then select 
Programs-->RoamAbout-->Client Utility.

3) Click on the Help menu and select Version Info from the drop-down list. 

If you encounter problems during the installation procedure you must 
uninstall the RoamAbout Driver before reinstallation.

If you receive a message stating that the Client Utility is not installed during 
the installation procedure, complete the installation. Then, go to Appendix 
A for the instructions to install the Client Utility.

Previous versions of the Client Utility do not support the new driver, 
therefore you must uninstall the previous version and install the new 
version before you configure the new driver.

NOTES
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Driver Configuration
Driver Configuration
To configure the driver view parameters, perform the following steps: 

1) Open the Control Panel.

2) Double-click on the Network icon. 

3) Double-click the RoamAbout adapter line. Refer to the online help and the 
RoamAbout Wireless 802.11 Networking Guide for more information.
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Chapter 3

Windows 2000 Driver

This chapter provides setup and installation information for the Windows 2000 NDIS 5 
miniport driver Version 6.25 to support the RoamAbout DS PC card in an 802.11 wireless 
LAN. This driver works with various versions of the RoamAbout PC Card. However, 
earlier versions of the RoamAbout PC Card do not support WEP Encryption and cannot be 
upgraded to support encryption. The Determining if your Card Supports Encryption 
provides the instructions to determine whether or not your PC Card supports encryption.

To install the RoamAbout driver, you should have a working knowledge of Microsoft 
Windows operations and a working knowledge of installing network adapter cards and 
network client software. 

In This Chapter

You must use the RoamAbout Windows 2000 Version 6.25 driver on 
Microsoft Windows 2000 platforms. The Microsoft Windows 2000 driver 
included with on the Windows 2000 CD does not support WEP encryption. 
Therefore, you must update the RoamAbout Windows 2000 driver.
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System Requirements
System Requirements

• Operating System: Microsoft Windows 2000

• Disk Space: 720 KB 

• 64 MB RAM 

Determining if your Card Supports Encryption
To determine if the RoamAbout PC Card supports encryption, perform the following:

• Check for a sticker on the back of the PC Card that states support for 40-bit or 128-bit 
encryption. 

or

• Run the Client Utility (if already installed). Click on the Help menu and select Version 
Info from the drop-down list. Check the Card field for WEP encryption allowed. If it 
does not list WEP encryption allowed, your card does not support this feature.

Installation

To extract and install the RoamAbout driver files, perform the following steps: 

1) Insert the RoamAbout PC Card. 

2) Start the installation, right-click on the My Network Places icon located on 
your desktop. Select Properties from the drop-down menu. The Network and 
Dial-up Connections dialog box appears.

3) Right-click on the Local Area Connections icon and select Properties from 
the drop-down menu. The Local Area Connections Properties dialog box 
appears. 

4) Click on the Configure button. The Cabletron RoamAbout 802.11 PC Card 
Properties dialog box appears.

If you have more than one adapter card installed, select the icon that 
displays RoamAbout 802.11 when you move your cursor over it.

NOTE
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Installation
5) Click on the Driver Tab.

6) Click on the Update Driver button. The Update Driver Wizard appears.

7) Click on Next to continue.

8) Click on the button next to Display a list of known drivers so that I can 
choose a specific driver.

9) Click on Next to continue.

10) Click on Have Disk. For example, the \Drivers\Win2000 directory on the 
CD-ROM. Or, if you downloaded the driver from the RoamAbout Wireless 
web site, in the directory you specified during the extraction of the 
downloaded file.

11) Click on WLRBT48 and click Open, and then OK to copy the files.

 RoamAbout 802.11 DS (Cabletron) is highlighted.

12) Click Next twice to continue.

13) The Digital Signature Not Found Dialog box appears. Click Yes to complete 
the installation.

14) Click Finish.

15) Click Close, and then OK to close the local Area Connection Properties 
dialog box.

16) If asked to reboot, select Yes.

During the driver installation, the system displays the RoamAbout properties 
Add/Edit Configuration Profile window.

17) Select the profile and click on the Edit Profile button. Enter the network 
configuration parameters, such as the Wireless Network Name.

If you are joining a wireless network with Access Points, enter values specific 
to the network such as the wireless network name. Press <F1> while in a 
properties window for information, or refer to the RoamAbout 802.11 
Wireless Networking Guide.

18) Close the window when done.

If you encounter problems during the installation procedure you must 
uninstall the RoamAbout Driver before reinstallation. NOTE
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Installation Verification
Installation Verification
To verify the RoamAbout PC Card Driver installation, perform the following steps: 

1) Install the RoamAbout Client Utility (see Appendix A).

2) To start the Client Utility, perform the following: 

Click on the Client Utility icon located on the System Tray of your Windows 
Task bar. 

or

From the Windows Task bar, click Start, then select 
Programs-->RoamAbout-->Client Utility.

3) Click on the Help menu and select Version Info from the drop-down list. 

Driver Configuration
To configure the driver parameters, perform the following steps: 

1) Open the Control Panel.

2) Double-click on the Wireless Network icon. 

Refer to the online help and the RoamAbout Wireless 802.11 Networking Guide for more 
information.

Previous versions of the Client Utility do not support the new driver, 
therefore you must uninstall the previous version and install the new 
version before you configure the new driver.
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Chapter 4

Windows Millennium Driver

This chapter provides setup and installation information for the Windows Millennium 
NDIS 5 miniport driver Version 6.25 to support the RoamAbout DS PC card in an 802.11 
wireless LAN. This driver works with various versions of the RoamAbout PC Card. 
However, earlier versions of the RoamAbout PC Card do not support WEP Encryption and 
cannot be upgraded to support encryption. The Determining if your Card Supports 
Encryption provides the instructions to determine whether or not your PC Card supports 
encryption

To install the RoamAbout driver, you should have a working knowledge of Microsoft 
Windows operations and a working knowledge of installing network adapter cards and 
network client software.

In This Chapter

Depending on your system configuration, your installation procedure may 
be slightly different from the procedures listed.
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System Requirements
System Requirements
• Operating System: Microsoft Windows Millennium

• Disk Space: 720 KB 

• 64 MB RAM 

Determining if your Card Supports Encryption
To determine if the RoamAbout PC Card supports encryption, perform the following:

• Check for a sticker on the back of the PC Card that states support for 40-bit or 128-bit 
encryption. 

or

• Run the Client Utility (if already installed). Click on the Help menu and select Version 
Info from the drop-down list. Check the Card field for WEP encryption allowed. If it 
does not list WEP encryption allowed, your card does not support this feature.

New Installations
The computer must be configured with the same network protocols used by the other 
network devices. The commonly used protocols include TCP/IP, IPX/SPX, and NetBEUI. 
Refer to the documentation provided by the network protocol software or operating system. 

To install the RoamAbout Windows Millennium driver, perform the following steps: 

1) Insert the RoamAbout PC Card. 

Windows Millennium starts the Add New Hardware Wizard.

2) Click on Next.

3) Select Specify the location of the driver (Advanced).

4) Click on Next.

When prompted, specify a location and then browse to the CD-ROM 
directory \Drivers\WinMe. Or, if you downloaded the driver from the 
RoamAbout Wireless web site, in the directory you specified during the 
extraction of the downloaded file.
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Reinstallation or Upgrade
5) Deselect Removable Media (Floppy, CD-ROM...) and select Specify a 
location.

6) Enter the path of the driver. For example, the \Drivers\WinME directory on 
the CD-ROM. Or, if you downloaded the driver from the RoamAbout 
Wireless web site, in the directory you specified during the extraction of the 
downloaded file.

7) Click on Next. 

8) If you are prompted for operating system files, insert the operating system 
media. 

During the driver installation, the system displays the RoamAbout properties 
Add/Edit Configuration Profile window.

9) Select the profile and edit the profile with your network configuration 
parameters, such as the Wireless Network Name. 

If you are joining a wireless network with Access Points, enter values specific 
to the network such as the wireless network name. Press <F1> while in a 
properties window for information, or refer to the RoamAbout 802.11 
Wireless Networking Guide.

10) Click Finish.

11) Restart the computer. 

Reinstallation or Upgrade
If this is an reinstallation or an upgrade to a previous Windows Millennium driver, perform 
the following steps:

1) Open the Control Panel and click on the System icon.

2) Click on the Device Manager tab.

3) Select RoamAbout 802.11 DS.

4) Click on Properties.

If you encounter problems during the installation procedure you must 
uninstall the RoamAbout Driver before reinstallation.

If you receive a message stating that the Client Utility is not installed during 
the installation procedure, complete the installation. Then, go to Appendix 
A for instructions to install the Client Utility.
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Reinstallation or Upgrade
5) Click on the Driver tab.

6) Click on Update Driver to start the Update Device Driver Wizard.

7) Select Specify the location of the driver (Advanced).

8) Click on Next.

9) Select Search for a better driver then the one your device is using now.

10) Deselect Removable Media (Floppy, CD-ROM...) and select Specify a 
location.

11) Enter the path of the driver. Enter the path of the driver. For example, the 
\Drivers\WinME directory on the CD-ROM. Or, if you downloaded the 
driver from the RoamAbout Wireless web site, in the directory you specified 
during the extraction of the downloaded file.

12) Click on Next.

The Update Device Driver Wizard displays "What would you like to install".

13) Select The Updated Driver (Recommended).

RoamAbout 802.11 DS (Cabletron) is shown.

14) Click on Next. 

The location of the driver is displayed. 

15) Click on Next. 

16) If you are prompted for operating system files, insert the operating system 
media. 

During the driver installation, the system displays the RoamAbout properties 
Add/Edit Configuration Profile window.

17) Select the profile and edit the profile with your network configuration 
parameters, such as the Wireless Network Name. 

If you are joining a wireless network with Access Points, enter values specific 
to the network such as the wireless network name. Press <F1> while in a 
properties window for information, or refer to the RoamAbout 802.11 
Wireless Networking Guide.

18) Click on Finish.
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Installation Verification
19) Restart the computer.

Installation Verification
To verify the RoamAbout PC Card Driver installation, perform the following steps: 

1) Install the RoamAbout Client Utility (see Appendix A)..

2) To start the Client Utility, perform the following: 

Click on the Client Utility icon located on the System Tray of your Windows 
Task bar. 
or

From the Windows Tasteable, click Start, then select 
Programs-->RoamAbout-->Client Utility.

3) Click on the Help menu and select Version Info from the drop-down list. 

Driver Configuration
To configure the driver parameters, perform the following steps: 

1) Open the Control Panel.

2) Double-click on the Wireless Network icon. 

Refer to the online help and the RoamAbout Wireless 802.11 Networking Guide for more 
information.

If you encounter problems during the installation procedure you must 
uninstall the RoamAbout Driver before reinstallation.

If you receive a message stating that the Client Utility is not installed during 
the installation procedure, complete the installation. Then, go to Appendix 
A for the instructions to install the Client Utility.

Previous versions of the Client Utility do not support the new driver, 
therefore you must uninstall the previous version and install the new 
version before you configure the new driver.

NOTES
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Chapter 5

Windows NT Driver

This chapter provides setup and installation information for the Windows NT NDIS 4 
miniport driver Version 6.25 to support the RoamAbout DS PC card in an 802.11 wireless 
LAN. This driver works with various versions of the RoamAbout PC Card. However, 
earlier versions of the RoamAbout PC Card do not support WEP Encryption and cannot be 
upgraded to support encryption. The Determining if your Card Supports Encryption 
provides the instructions to determine whether or not your PC Card supports encryption.

To install the RoamAbout driver, you should have a working knowledge of Microsoft 
Windows operations and a working knowledge of installing network adapter cards and 
network client software.

In This Chapter

Depending on your system configuration, your installation procedure may 
be slightly different from the procedures listed.
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System Requirements
System Requirements

• Operating System: Microsoft Windows NT, with Service Pack 4 or later

• Disk Space: 170 KB 

• 16 MB RAM 

Determining if your Card Supports Encryption
To determine if the RoamAbout PC Card supports encryption, perform the following:

• Check for a sticker on the back of the PC Card that states support for 40-bit or 128-bit 
encryption. 

or

• Run the Client Utility. Click on the Help menu and select Version Info from the drop-
down list. Check the Card field for WEP encryption allowed. If it does not list WEP 
encryption allowed, your card does not support this feature.

Windows NT System Configuration for New Driver 
Installation

If this is the first time you are installing the driver, perform the following steps before you 
install the RoamAbout driver:

1) Enable the PC Card controller, perform the following steps:

a) In the Control Panel, double-click on the PC Card icon to open the PC 
Card Properties window. 

b) Double-click one of the PC Card sockets to enable it. 

c) Click OK and close the PC Card Properties window.

Installation Verification 5-6

Driver Configuration 5-7
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New Installations
2) Run diagnostics to avoid a device conflict, perform the following steps:

When you install the driver, Windows NT prompts you to confirm or modify 
the factory-set device values for the PC Card I/O port (0400-043F) and IRQ 
(10). To make sure that you use available I/O port and IRQ values, perform 
the following steps:

a) Click Start and select Programs-->Administrative Tools-->Windows 
NT Diagnostics.

b) Click on the Resources tab. If IRQ 10 is shown as being used, write 
down an IRQ not listed in the window, such as 9 or 11.

Click the I/O Port button. If 0400-043F is shown as being used, write 
down an unlisted I/O port value in the range 0300 to FFC0 with 
increments of 40. Examples: 0300, 0340, 0380, 03C0; 0400, 0440, 0480, 
04C0; . . . FF00, FF40, FF80, FFC0. Typically, addresses before 0400 are 
used even if not shown in the window. 

3) Enable network support:

a) In the Control Panel, double-click on the Network icon.

b) Click Yes if prompted to install the network protocols. Otherwise, select 
the Adapters tab then click Add. 

c) Go to Step 5 in New Installations.

New Installations
The computer must be configured with the same network protocols used by the other 
network devices. The commonly used protocols include TCP/IP, IPX/SPX, and NetBEUI. 
Refer to the documentation provided by the network protocol software or operating system.

To install the RoamAbout Windows NT driver, perform the following steps: 

1) Insert the RoamAbout PC Card.

2) Open the Control Panel and double-click on the Network icon. 

3) Select the Adapters tab and click on the Add button.

You must configure your NT system as described in the Windows NT 
Configuration for New Driver Installation before you install the driver.NOTE
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4) Click on Have Disk. 

Enter the path of the driver. For example, the \Drivers\WinNT directory on 
the CD-ROM. Or, if you downloaded the driver from the RoamAbout 
Wireless web site, in the directory you specified during the extraction of the 
downloaded file. 

The RoamAbout 802.11 PC Card is highlighted.

5) Click OK.

6) If you are prompted for operating system files, insert the operating system 
media.

7) Enter the IRQ and I/O port values if prompted. 

During the driver installation, the system displays the RoamAbout properties 
Add/Edit Configuration Profile window.

8) Select the profile and click on the Edit Profile button. Enter your 
configuration parameters, such as the Wireless Network Name. 

If you are joining a wireless network with Access Points, enter values specific 
to the network such as the wireless network name. Press <F1> while in a 
properties window for information, or refer to the RoamAbout 802.11 
Wireless Networking Guide.

9) Click OK to close the window when done.

10) You may need to configure the protocols at this time. 

11) Reboot your computer.

If you encounter problems during the installation procedure you must 
uninstall the RoamAbout Driver before reinstallation. Go to the 
Reinstallation or Upgrade section of this document.
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Reinstallation or Upgrade
If this is an reinstallation or an upgrade to a previous Windows NT driver, perform the 
following steps: 

1) Shutdown your computer.

2) Remove the RoamAbout PC Card.

3) Reboot your system.

4) From the Task bar on the Windows desktop, click Start then select 
Settings--> Control Panel.

5) In the Control Panel window, double-click on the Network icon.

6) In the Network Properties window, select the Adapters tab.

7) Highlight RoamAbout 802.11 DS and click on the Remove button.

8) Click Yes to continue. 

9) Exit out of the Control Panel.

10) Reboot your system.

11) Insert the RoamAbout PC Card.

12) Double-click on the Network icon. 

13) Select the Adapters tab and click on the Add button.

14) Click on Have Disk.

15) Enter the path of the driver. For example, the \Drivers\WinNT directory on 
the CD-ROM. Or, if you downloaded the driver from the RoamAbout 
Wireless web site, in the directory you specified during the extraction of the 
downloaded file.

The RoamAbout 802.11 PC Card is highlighted.

16) Click OK.

17) If you are prompted for operating system files, insert the operating system 
media. 

18) Enter the IRQ and I/O port values if prompted. 

19) During the driver installation, the system displays the RoamAbout properties 
Add/Edit Configuration Profile window.
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20) Select the profile and edit the profile with your network configuration 
parameters, such as the Wireless Network Name. 

If you are joining a wireless network with Access Points, enter values specific 
to the network such as the wireless network name. Press <F1> while in a 
properties window for information, or refer to the RoamAbout 802.11 
Wireless Networking Guide.

21) Close the window when done.

22) You may need to configure the protocols at this time.

23) Reboot your computer. 

Installation Verification
To verify the RoamAbout PC Card Driver installation, perform the following steps: 

1) Install the RoamAbout Client Utility (see Appendix A)..

2) Start the Client Utility, perform the following: 

Click on the Client Utility icon located on the System Tray of your Windows 
Tasteable. 

or

From the Windows Tasteable, click Start, then select 
Programs-->RoamAbout-->Client Utility.

3) Click on the Help menu and select Version Info from the drop-down list. 

If you encounter problems during the installation procedure you must 
uninstall the RoamAbout Driver before reinstallation. 

Previous versions of the Client Utility do not support the new driver, 
therefore you must uninstall the previous version and install the new 
version before you configure the new driver.

NOTE

NOTE
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Driver Configuration
To configure the driver parameters, perform the following steps: 

1) Open the Control Panel.

2) Double-click on the Wireless Network icon.

3) In the Network Properties window, select the Adapters tab.

4) Double-click the RoamAbout Adapter line. 

Refer to the online help and the RoamAbout Wireless 802.11 Networking Guide for more 
information.
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Chapter 6

 Windows CE Driver

This chapter provides setup and installation information for the RoamAbout 802.11 PC 
Card Driver for Microsoft Windows CE.

To install the RoamAbout driver, you should have a working knowledge of Microsoft 
Windows CE operations and a working knowledge of installing network adapter cards and 
network client software.

In This Chapter

Windows CE Limitations: For users familiar with Windows Operating 
Systems, please be aware that Windows CE does not contain all the 
communications capabilities that you might expect. For example, two 
Windows CE devices cannot communicate with each other, but can 
communicate with other Windows based systems. Consult the Windows CE 
documentation for more information.

Section Page

System Requirements 6-2

Pre-installation Requirements 6-2

Installation 6-3

Driver Configuration 6-4
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System Requirements

• Operating System: Windows CE 2.11 

• Disk Space: 170 KB 

• 16 MB RAM 

• Certified Handhelds: Windows CE V2.11:

—  Compaq Areo

— HP Jornada 680

— HP Jornada 820

— NEC Mobile Pro 770

— Sharp Tripad

— Sharp Mobilon Pro PV-5000 

Pre-installation Requirements

To use the RoamAbout 802.11 DS PC Card with your device using the current driver,
handheld device must match the following requirements. 

• Ensure that Microsoft Windows CE Services, ActiveSync, is installed on your 
operating system to download the files to your Windows CE device. For more 
information about the Windows CE Services refer to the Microsoft Handheld PC
Companion booklet and your handheld device user documentation. 

If you do not have the Windows CE services on your handheld, you can download it f

http://www.microsoft.com/TechNet/WCE/tools/actsync.asp 

At the time of this release the Microsoft URL was accurate.
NOTE
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• Determine that  your Windows CE device is supported, perform the following: 

1) Select Start-->Settings-->Control Panel from the Windows Task bar. 

2) In the Control Panel, double-click on the System icon. 

3) Click on the Device tab to view the processor type. Verify that the processor 
type is one of the following: 

— MIPS

— SH3

— SH4

— ARM, 

— X86 

4) Click on the System tab to view the Windows CE version. Verify that the 
Core System version is 2.11. 

Installation

The handheld PC (H/PC) Windows CE devices are used in combination with anothe
computer running Windows CE Services, ActiveSync, to transfer data between the de
computer and the HPC device.

To install the RoamAbout driver on your handheld device, perform the following step

1) Copy the WinCE driver directory to the computer running the Windows C
services.

2) Connect the serial cable or docking device of your handheld device to th
computer that you are using to install the software. 

3) Run the RoamAbout executable file on the computer that is running the 
Windows CE Services to allow you to transfer the files to your handheld
computer:

Rmabt404CE211.exe 

Browse to the CD-ROM directory \Drivers\WinCE. Or, if you downloaded 
the driver from the RoamAbout Wireless web site, in the directory you 
specified during the extraction of the downloaded file.

NOTE
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The Windows CE Services automatically transfers the files to your H/PC device.

Driver Configuration

To view or modify the RoamAbout configuration parameters, open the Control Panel on 
your Windows CE device and double-click the RoamAbout Settings icon. Configuration 
information is described in the online help and the RoamAbout 802.11 Wireless Networking 
Guide. The RoamAbout Wireless documentation is also available from the RoamAbout 
Wireless web site: 

http://www.enterasys.com/wireless

If you experience problems copying the RoamAbout driver files to your 
Windows CE device, refer to the Microsoft Handheld PC Companion 
booklet and the user documentation of your H/PC device for more 
information about installing and/or troubleshooting the Windows CE 
Services.
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Chapter 7

Linux Driver

This chapter provides setup and installation information for the RoamAbout 802.11 PC 
Card Driver on a Linux system. You should have a working knowledge of Linux operations 
and a working knowledge of installing network adapter cards and network client software. 

In This Chapter
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Distribution Kit Contents 7-2
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How to Configure PCMCIA Services on your 
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7-3
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Binary Distribution

7-4

How to Configure the RoamAbout DS PC Card 7-5
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without Binary Support
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Troubleshooting 7-18
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Operating System Support
Operating System Support
The following Linux operating systems are supported: 

• Red Hat V6.1 and V6.2

• Caldera V2.3  and V2.4

• SuSE V6.3 and V6.4

The binaries for the supported operating systems are loaded under the default workstation 
installation kernels. If you need a driver for an operating system not listed as supported, the 
source code (and binary hardware interface code as part of the driver) is provided to build 
the device driver on Version 2.2 kernel-based Linux systems. This procedure is described 
in the How to Manually Configure the Driver Parameters on page 7-10 of this 
document.

Distribution Kit Contents

Location/Filename 
after Installation

Description

/usr/local/Enterasys/RoamAbout/RoamAbout_Linux.html This file contains the RoamAbout 802.11 DS 
PC Card Linux Driver setup and installation 
information.

/usr/local/Enterasys/RoamAbout/RedHat6_1.o, RedHat6_2.o, 
Caldera2_3.o, Caldera2_4.o, SuSE6_3.o, SuSE6_4.o

The binary device driver modules for the 802.11 
RoamAbout DS PCMCIA card.

/etc/roamabout_cs.patch
/etc/roamabout_cs.SuSE64.patch

The file that creates an entry for the RoamAbout 
card in /etc/pcmcia/config.

/usr/local/Enterasys/RoamAbout/RoamAboutInstall.sh Unpacks the binary rpm distribution.

/usr/local/Enterasys/RoamAbout/RoamAboutUnInstall.sh Restores config files from their originally saved 
values and deletes kit files.

/usr/local/Enterasys/RoamAbout/RoamAbout-1-3.i386.rpm The binary RPM kit file.

/usr/local/Enterasys/RoamAbout/RoamAbout-1-3-src.tar The source files and HCF binary library 
required to build a binary driver module. Use 
these files to build a driver module on systems 
that Enterasys does not ship a binary, such as 
Debian.
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Installation Overview 

The following is an overview of the RoamAbout PC Card Linux driver installation 
sequence. In the text that follows xxx stands for the numerical designation of the release 
number, such as 101, 102, 200, etc. 

1) Copy the Linux driver directory to the computer.

2) Ensure that PCMCIA services are configured on your computer. See How to 
Configure PCMCIA Services on your Computer on page 7-3.

3) Mount and extract the binary distribution file. See How to Mount and 
Extract the RoamAbout 802.11 DS Binary Distribution on page 7-4. 

4) Setup the RoamAbout configuration parameters. See How to Configure the 
RoamAbout DS PC Card on page 7-5. 

5) Restart the computer to verify that the PCMCIA services starts successfully 
and the network driver is loaded. 

How to Configure PCMCIA Services on your Computer 

If you had a PCMCIA based device attached to your computer when you installed the 
operating system, the PCMCIA services are probably already configured. To verify that the 
Linux PCMCIA services on your computer are installed and configured, perform the 
following steps: 

Ensure that PCMCIA services are configured for your computer.

1) If you are unsure of the status of the PCMCIA services on your computer, 
perform the following steps: 

a) Enter rpm -qa | grep pcmcia at the command line. 

If pcmcia (for example, pcmcia-cs-3.1.8) is not listed, install the pcmcia 
package from the Linux Kernel Installation CD-ROM. 

If pcmcia is listed go proceed to Step b.

Browse to the CD-ROM directory \Drivers\Linux. Or, if you downloaded the 
driver from the RoamAbout Wireless web site, in the directory you specified 
during the extraction of the downloaded file.

NOTE
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b) Enter lsmod at the command line. 

Ensure that pcmcia_core and i82365 appear in the list. If they are both 
listed, go to Step 2. 

If both of them are not in the list, then the pcmcia modules are not 
loading. To load these modules proceed to Step c.

c) If you are running on Red Hat or Caldera system, edit the /etc/sysconfig/
pcmcia file with the following:

Set the first line to pcmcia=yes

Set the second line to PCIC=i82365 

d) Save the changes.

2) Go to How to Mount and Extract the RoamAbout 802.11 DS Binary 
Distribution.

How to Mount and Extract the RoamAbout 802.11 DS 
Binary Distribution

To mount and extract the RoamAbout 802.11 DS binary distribution, perform the following 
steps: 

1) Change the directory/usr/local to where rmbt-xxx.gz is located.

2) Mount the CD-ROM as a DOS file system under Linux:

# mount -t msdos/dev/fd0 /mnt

3) Enter the following command to copy the distribution file to the Linux 
computer:

# cp /mnt/rmbt-xxx.gz /usr/local/rmbt-xxx.gz

4) Enter the following command to extract the file:

# tar xvfz rmbt-xxx.gz

This section assumes that you have root privileges.
NOTE
 7-4  



How to Configure the RoamAbout DS PC Card

ee  

r 
e 

s 
rted 
 the /
d. 
The following files are extracted under /usr/local in the Enterasys directory:

./Enterasys/RoamAbout/RoamAbout-1-3.i386.rpm

./Enterasys/RoamAbout/RoamAbout-1-3-src.tar

./Enterasys/RoamAbout/RoamAbout_Linux.html

./Enterasys/RoamAbout/RoamAboutInstall.sh

./Enterasys/RoamAbout/RoamAboutUninstall.sh

5) Change the directory to /usr/local/Enterasys/RoamAbout.

6) Enter the following command to install the binary distribution:

 #sh RoamAboutInstall.sh

This command executes rpm -ivh RoamAbout-1-3.i386.rpm and places the 
collection of loadable modules containing the roamabout_cs.o binary driver, 
supporting different kernel versions, in /usr/local/Enterasys/RoamAbout.

How to Configure the RoamAbout DS PC Card 

This section describes how to configure the Configure the RoamAbout 802.11 DS PC Card. 
Refer to the RoamAbout DS PC Card Parameter Information and the PCMCIA 
documentation for information. 

1) Execute the configuration script user string included with the RoamAbout 
802.11 DS PC package by entering the following command: 

# /usr/local/bin/RoamAboutConfig.sh 

This script specifies parameters required by the driver to operate the card and to 
communicate with an Access Point or another computer (for example, ad-hoc or peer-to-
peer networking). The script deals with only the basic set of possible parameters that might 
be used which are crucial to the operation of the RoamAbout client card. The script does 
not prompt or configure such parameters as ‘power management’ and ‘ap density’. S
RoamAbout DS PC Card Parameter Information on page 7-13 for more information 
about the complete set of configuration parameters. Please be aware that paramete
specifications for network name and station name are limited to upper and lower cas
letters, spaces, underscores, and numbers.

As part of the script operation, a patch places an entry and a "binding" in the file. Thi
allows the roamabout_cs.o to load when the PCMCIA RoamAbout client card is inse
in one of the computer's PCMCIA slots. The patching operation includes a change to
etc/pcmcia/config.opts which allows one of the IRQ lines to be used for the client car
Each computer varies in the way the IRQ lines are distributed and protected. 
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The patch operation choice may take the interrupt away from a serial port or a parallel port. 
Some juggling may be required when it comes to allocating interrupts. If the PCMCIA card 
driver does not load, see Troubleshooting on page 7-18 for information to resolve this 
problem.

The script also makes the necessary changes in /etc/pcmcia/config.opts to load the driver 
module and configure it with operational parameters. The configuration interface has a size 
limit of 195 characters long for all configuration parameters. This includes parameter 
names, values, spaces, quotes, equal signs, and other characters that appear in the ’opts’ 
string specification.

An example of a configuration that does not exceed the character limit: 

Network name: RoamAbout in Raleigh
Station name: My Station
Enable encryption: Y
Key_1: 12345
Key_2: abcde
Key_3: John1
Key_4: Vicky
Transmit_key_id: 2 

An example of a configuration that exceeds the character limit using the 128- bit WEP 
IEEE 802.11 card: 

Network name: RoamAboutWireless in Paducah_Kentucky
Station name: Best Station on the Network
Enable encryption: Y
Key_1: 1234567890123
Key_2: abcdefghijklm
Key_3: EnterasysSyst
Key_4: Wireless-LANs
Transmit_key_id: 2

If you need to manually edit /etc/pcmcia/config.opts or understand in detail the parameter 
specification limits, review the RoamAbout DS PC Card Parameter Information. The 
RoamAbout card configuration also allows DHCP configuration. The DHCP configuration 
for the card is offered as a convenience to get you up and running quickly. It is not intended 
as a substitute for a thorough Linux networking configuration approach. 
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2) Reboot the computer to restart the PCMCIA services and system services by 
entering one of the following commands: 

# shutdown now

or

# halt

When the computer is shutdown or halted, insert the RoamAbout wireless LAN client card 
in one of the PCMCIA slots. Then boot the computer. If you chose automatic IP address 
assignment via DHCP during the execution of /usr/local/bin/RoamAboutConfig.sh, the 
network card should be indicating it is working upon reaching the login prompt by one 
solidly lit green LED and one rapidly blinking LED. 

3) Configure the network interface for the card if you are not using DHCP.

a) After you log back into the system, examine the state of the networking 
adapters used, by the system by entering the following command:

# ifconfig -a

b) From the information shown, determine the name of the RoamAbout 
device such as eth0 or eth1 and configure an IP address and netmask for 
the adapter, by entering the following command:

# ifconfig eth1 10.100.100.133 netmask 
255.255.255.0

c) Enter ifconfig -a again to determine that the RoamAbout device is ready 
to communicate. 

d) At this point you can ’ping’ a target on the same network and get a 
positive response. For example:

# Test with ping (ex: ping 10.100.100.110) 

You are now ready to use wireless networking. Typically you would want to use the DHCP 
server to supply an IP address through a RoamAbout Access Point to avoid the manual 
configuration steps.
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Per-Distribution Configuration Notes

The following information is an accumulation of particular information 
pertinent to some distributions supported by Enterasys Networks, Inc.

Red Hat 6.2
The default workstation installation using Red Hat 6.2 requires the installation of certain 
networking kits after the main installation has concluded. This represents a change from 
Red Hat 6.1, which installed these components on a default basis. The kits required to be 
installed are: inetd-0.16-4, containing the networking services daemon, and pump-0.7.8-1, 
containing the dhcp client. These RPMs can be found on the Red Hat 6.2 CD-ROM #1 in 
the directory /RedHat/RPMS.

SuSE 6.4
To get SuSE 6.4 properly configured for DHCP operation the following binary RPM needs 
to be in place, dhcpcd-1.3.18p3-13, which can be verified as installed by the command, 
’rpm -qa | grep dhcpcd-1.3.18p3-13’. This RPM contains the DHCP client, /sbin/dhcpcd. 

In addition, the following parameters need to be specified:

In file: /etc/rc.config

NETCONFIG="_0"

NETDEV_0="eth0"

IFCONFIG_0="dhcpclient"

DHCLIENT="yes"

In file: /etc/pcmcia/network.opts

DHCP="n" 

This above parameter disconnects the PCMCIA DHCP operation and allows the standard 
DHCP run level script, /etc/rc.d/init.d/dhclient, to perform the operation of getting the 
DHCP client started. This is done to allow proper timing between the loading of the 
RoamAbout device driver and DHCP client service request
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How to Change Kernels and Work with Distribution without 
Binary Support

If you change kernels and library modules sets you need to build a new driver binary. 
Enterasys only supports the default installation kernels in the supported distributions. You 
cannot copy over or reload the module from the new library module directory. The versions 
and external symbols will not match and cause the load to fail. Versions are checked during 
the load to match the running kernel. If you are building from source, you must create a 
kernel development environment for your Linux computer. 

The following procedure assumes that the kernel source tree and the PCMCIA segment of 
the kernel source tree are installed for your particular distribution. 

1) Move the driver source tar file, RoamAbout-1-3-src.tar to /usr/src/linux/
pcmcia-XXX (XXX to denote the suffix value of your particular PCMCIA 
distribution)

a) Change directories to /usr/src/linux/pcmcia-XXX.

b) Enter the following command to populate the PCMCIA area with the 
required files:

tar xvf RoamAbout-1-3-src.tar

c) Enter the following command:

make config

Answer the questions presented to create the proper configuration to build the 
PCMCIA package, or parts of the package.

d) Enter the following command to build the loadable device driver file, 
roamabout_cs.o, which resides in the ’clients’ directory under the pcmcia 
directory: 

make -f roamabout_cs.mk all 

2) Move roamabout_cs.o to the library modules directory /lib/modules/‘uname 
-r‘/pcmcia.

3) Enter the following command to perform the card configuration (skip this 
procedure if you want to perform the configuration manually): 

/usr/local/bin/RoamAboutConfig.sh 
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How to Manually Configure the Driver Parameters

There are limits to the size and numbers of parameters that you can configure in this release. 
This means that you may not be able to configure all of the parameters at once. See 
Example 1, Example 2, and Example 3. 

Example 1

The "opts" string in etc/pcmcia/config.opts was tested at the maximum of 195 characters. 
Character counts include the equal sign (=), the value of the parameter including quotes ("", 
‘’), escape signs (\), and spaces contained in and surrounding the parameter.

For example, operating a client card in a network with an Access Point using the follo
specified parameters; network_name, station_name, enable_encryption=y, key_1=1
and transmit_key_id=1. The specification takes up to 81 characters on the "opts" str
This leaves 114 characters to divide between the network_name, the station_name a
other parameters. Since the network_name has a limit of 32 characters and the 
station_name has a limit of 20 characters, for a total of 52 characters, there would be
leftover space. 

A syntax example for the entire line without the network name and station name fille
(Remember do not count the characters up to and including the open quote after opt a
close quote after transmit_key_id=1):

module "roamabout_cs" opts "network_name=
station_name= enable_encryption=Y key_1=\"12345\"
transmit_key_id=1" 

Example 2

Use the same parameters specified in Example 1 with the addition of 4 keys at the 4
5 ascii character specification. The "opt’ string in this example is 130 characters with
the network_name or the station_name specified. This leaves a total of 65 character
divide between the network_name, station_name, and any other parameters desired

Syntax example:

module "roamabout_cs" opts "network_name=
station_name= enable_encryption=Y key_1=\"12345\"
key_2=\"12345\" key_3=\"12345\" key_4=\"12345\"
transmit_key_id=1"

A syntax example of the same string with a network name and a station name filled 
reference:
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module "roamabout_cs" opts "network_name=RoamAbout1
station_name=Cynthia enable_encryption=Y key_1=\"12345\"
key_2=\"12345\" key_3=\"12345\" key_4=\"12345\"
transmit_key_id=1"

Example 3

Use the same parameters specified in Example 2 with the following additional parameters 
increased;  key_1=1234567890123, key_2=1234567890123, and transmit_key_id=1. The 
"opt’ string in this example is 146 characters, leaving 49 characters to use for the 
network_name and the station_name.

Syntax example:

module "roamabout_cs" opts "network_name=
station_name= enable_encryption=Y key_1=\"1234567890123\"
key_2=\"1234567890123\" key_3=\"12345\" key_4=\"12345\"
transmit_key_id=1"

To manually configure the driver, perform the following steps: 

1) If you need background information read the Linux PCMCIA-HOWTO by
David Hinds. You can read the HOWTO section by entering the followin

# more PCMCIA-HOWTO 

2) Add the following lines to the /etc/pcmcia/config file:

device "roamabout_cs"
class "network’ module "roamabout_cs"

and the line

card "Cabletron RoamAbout 802.11"
      version "Cabletron","Roamabout 802.11 DS" 
      bind "roamabout_cs"

3) Edit the  /etc/pcmcia/config.opts file using the following examples.

Examples: 

a) To attach to an Access Point with the network name of "My Network
you enter the following in the config.opts file:

module "roamabout_cs" opts "network_name=My\ 
Network" 

Notice that the space character needs to be escaped with a back sla
 7-11



How to Manually Configure the Driver Parameters
b) For the Ad-Hoc (peer-to-peer) network without an access point, enter the 
following in the config.opts file:

module "roamabout_cs" opts "port_type=3"

c) To attach to an Access Point with the network name of "Ocean", and 
export the station name as "Wander", enter the following in the 
config.opts file:

module "roamabout_cs" opts "network_name=Ocean 
station_name=Wander"

4) Reboot your computer. 
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RoamAbout DS PC Card Parameter Information

NAME

roamabout_cs - RoamAbout 802.11 PC Card device driver

SYNOPSIS

insmod roamabout_cs.o [irq_mask=n] [irq_list=i,j,...]

[pc_debug=n] [debug_flags=n] [network_name=s]

[port_type=n] [channel=n] [ap_density=n] [transmit_rate=n]

[medium_reservation=n] [card_power_management=s]

[receive_all_multicasts=s] [maximum_sleep_duration=n]

[mac_address=n,n,n,n,n,n] [station_name=s] [enable_encryption=s] [key_1=s] 

[key_2=s] [key_3=s] [key_4=s] [transmit_key_id=n]

DESCRIPTION

roamabout_cs is the low-level Card Services driver for the RoamAbout 802.11 PC Card 
adapters. When this driver is attached to a card, it allocates the next available Ethernet 
device (eth0..eth#). This device name will be passed on to cardmgr(8) for the card 
configuration, and reported in the kernel log file with the I/O base address and MAC 
address used by the card.

FEATURES

- Hot plug/unplug

- Access Point and Ad-Hoc (peer-to-peer) communication

- Card power management

- Interference Robustness

- 3.3 /5 volt cards

- Driver utility interface (UIL)

- 11 MHz card support

- Wired Equivalent Privacy (WEP)
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PARAMETERS

irq_mask=n 

Specifies a mask of valid interrupts that may be allocated by this driver. If 

irq_list is also specified, the values in irq_list are used instead.

Default: 0xdeb8 (IRQ 3,4,5,7,9,10,11,12,14,15)

irq_list=i,j,...

Specifies the set of interrupts (up to 4) that may be allocated by this driver. This overrides 
the values set in the irq_mask parameter.

pc_debug=n

Selects the PCMCIA debugging level. This parameter is only available if the module is 
compiled with debugging enabled. A non-zero value enables debugging.

debug_flags=n

Selects the driver debugging level. This parameter is only available if the module is 
compiled with debugging enabled. Refer to the file debug.h in the source directory for 
information on the flag values.

network_name=s

Sets the card network name to the specified string value. This parameter accepts a 
maximum of 32 characters. Whitespace in the network name will need to be escaped with 
a back slash (for example, network_name=My\ Network). 

Default: My_Network

port_type=n

Selects the type of network operation.

1 - Normal Operation (BSS)

3 - Ad-Hoc Demo Mode

Default: 1 
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channel=n

Sets the channel the Ad-Hoc network will use. This value has no effect when the adapter is 
used with an Access Point (Normal Operation BSS network) since the Access Point 
automatically determines the channel. Valid values are 0 to 14. However the channels 
allowed in your region are subject to local regulations and are limited at manufacturing time 
of the RoamAbout PC Card. When the provided value is not allowed, the value remains 
unchanged.

0 - Use default channel

Default: 0

ap_density=n

Sets the density of the Access Points in the network. This value influences the Modem 
Thresholds.

(EnergyDetectThreshold, CarrierDetectThreshold and DeferThreshold) and the Roaming 
Thresholds (CellSearchThreshold and OutOfRangeThreshold).

1 - Low

2 - Medium

3 - High

Default: 1

transmit_rate=n

Sets the data rate to be used by the transmitter.

1 - Fixed Low

2 - Fixed Standard

3 - Auto Rate Select (High)

4 - Fixed Medium

5 - Fixed High

6 - Auto Rate Select (Standard)

7 - Auto Rate Select (Medium)

Default: 3
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medium_reservation=n

Sets the number of octets in a message or fragment above which a RTS/CTS handshake is 
performed.

Valid values are 0 to 2347.

500 - Hidden Stations

2347 - No RTS/CTS

Default: 2347

card_power_management=s

Enable or disable card Power Management.

N - Disable

Y - Enable

Default: N 

receive_all_multicasts=s

Enable or disable receiving of all multicast packets when Card Power Management is 
enabled. When enabled, the station will wake up frequently to receive the multicast frames. 
This causes less optimal power savings.

N - Disable

Y - Enable

Default: Y

maximum_sleep_duration=n

Set the maximum Power Management sleep duration in milliseconds. Valid values are 0 to 
65535 milliseconds.

Default: 100

mac_address=n,n,n,n,n,n

Sets the adapter hardware Ethernet address (MAC address) to the value specified. Note that 
this is to be used to specify a Local MAC address. Do not specify this parameter if the card’s 
universal address is to be used. Valid values are six hexadecimal digit-pairs (prefixed with 
0x). Default: <factory assigned address>
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station_name=s

Sets the station name to the specified string value. This parameter is used for diagnostic 
purposes, as a user-friendly identification of this system. This parameter accepts a 
maximum of 20 characters.

Default: My_Station

enable_encryption=s

Enables or disables encryption of Data, provided the card supports Data Encryption (i.e. 11 
Mb cards supporting 40 bit or the advanced 128 bit encryption version).

N - Disable

Y - Enable

Default: N

key_1=encryption_string_1

Specifies one of 4 possible keys for the Data encryption. One of these keys, identified by 
Transmit_Key_ID, is used for the enciphering of Data that is 

transmitted by this station. All keys specified can be used for the deciphering of Data that 
is received. The key value can be an ASCII character string or a hexadecimal value. The 
length of the key value can be 5 characters or 10 hexadecimal digits for the standard 
encryption (40 bit or 128 bit card), or 13 characters or 26 hexadecimal digits for the 
encryption with extended keys (128 bit encryption card only). The keys defined in the 
station must match the keys defined in the access points; both on value and number (1 
through 4). In 2.0 series Linux kernel modules, values that begin with a number are 
considered integers. In this case a hexadecimal value string or a character string starting 
with a number, will need to be surrounded by escaped back slashes (for example, 
key_1=\"0x1122334455\" key_2=\"12xyz\"). 5 or 13, printable character string, or 10 or 26 
hex digits if preceded by "0x".

If this parameter is omitted, the default of the MAC is used ( = 0-length).

key_2= encryption_string_2

Same as key_1.

key_3= encryption_string_3

Same as key_1.

key_4= encryption_string_4
 7-17



Troubleshooting
Same as key_1.

transmit_key_id=n 

Designates which of the keys is to be used for the enciphering of data that is transmitted by 
this station.

Integer in the range 1..4.

Default: 1

SECURITY

On a multi-user system only the system administrator needs access to the WEP encryption 
keys. In this case, consider to remove the read permission for normal users of the PCMCIA 
config.opts file and the system log file.

Troubleshooting 

This section provides basic troubleshooting information. 

Beeps 

When the RoamAbout 802.11 DS PC Card is inserted, the card manager will emit beeps in 
different tones to indicate success or failure of particular configuration steps.

Two high beeps 

The card was identified and configured successfully.

One high beep followed by a low beep 

The card was identified, but could not be configured. Examine the system log (dmesg) for 
PCMCIA error or warning messages.

One low beep 

The card could not be identified. 

• Execute "cardctl ident" to display the adapter PnP information. Verify the PnP 
information matches an entry in the PCMCIA configuration file (/etc/pcmcia/config). 

• Examine the system log (dmesg) for PCMCIA error or warning messages.
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LEDs 

The RoamAbout 802.11 DS PC Card has two LEDs that indicate the state of the adapter 
and network.

Power LED (toward the middle of the adapter) 

This LED indicates that the power is on, and that the card is functional. In normal operation 
mode with Card Power Management disabled, it is on. If Card Power Management is 
enabled, the LED blinks rapidly (several times per second). If the LED is off, there is a 
problem with the configuration. 

• The most common problem is that IRQs are not properly chosen in /etc/pcmcia/
config.opts. Review the settings in the /etc/pcmcia/config.opts file. 

• Execute ’tail -f /var/log/messages’. Then, remove the card and reinsert the card. You 
may receive messages indicating the PCMCIA subsystems attempt to configure and 
manage the card. These messages may provide an answer to the problem. 

Transmit/Receive LED (closer to the edge of the adapter) 

This LED flashes when it transmits or receives packets.

Both LEDs blink at the same time every 10 seconds 

The adapter was unable to make contact with the named wireless network. Verify the 
network_name, in the config.opts file matches the network name of the access point.

LEDs indicate normal operation, but no traffic 

The Power LED is on or blinking rapidly, and the Transmit/Receive LED is flashing, but 
there’s no traffic. 

• If the network is operating in normal mode (for example, port_type = 0 or not 
specified), and a network_name has been specified, verify that the workstation 
network parameters (ifconfig, route, etc.) are correct for the wireless network. 

• If the network is operating in Ad-Hoc (peer-to-peer) mode (for example, port_typ
3), the adapter needs another workstation/adapter to communicate with. Verify th
network parameters on both of the workstations (ifconfig, route, etc.) are correct

Refer to theRoamAbout DS PC Card Parameter Information section for additional 
configuration, feature and support information. 
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Chapter 8

MS-DOS and Workgroup
for Windows Driver

To install the RoamAbout driver on an MS-DOS or Microsoft Windows for Workgroups 
(usually referred to as Windows 3.1) system, you should have a working knowledge of 
MS-DOS operations and a working knowledge of installing network adapter cards and 
network client software.

For complete setup and installation information, refer to the RoamAbout 802.11 DS PC 
Card MS-DOS and Windows 3.1 Installation Guide located on the RoamAbout 802.11 PC 
Card Drivers and Utilities CD-ROM. Or, download the document from the RoamAbout 
Wireless web site.

In This Chapter
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Driver Types
Driver Types

There are two RoamAbout drivers available for your MS-DOS or Windows 3.x system:

• RoamAbout DOS ODI driver (WVLAN43.COM)

• RoamAbout packet driver (WVLAN42.COM)

The RoamAbout DOS ODI driver is typically used with the Novell NetWare client 
software.

To install these network drivers, you also need a program called the RoamAbout PC Card 
access driver (WVLANCAD). The WVLANCAD software is included with the 
RoamAbout driver software. The WVLANCAD driver enables you to access the PC Card 
via any PC Card slot that is controlled by an Intel 82365 PCIC or computers that support 
Card and Socket Services. 

Installation Overview

The following is an overview of the RoamAbout PC Card driver installation. Use MS-DOS 
to install the RoamAbout driver on a Windows 3.x system. 

1) Copy the DOS directory to your computer

2) Setup the WVLANCAD program.

3) Install the network client software for your network operating system.

4) Setup the RoamAbout configuration parameters.

5) Restart the computer to verify that WVLANCAD executes successfully and 
the network driver is loaded.

To setup the various configuration parameters, you may need to edit a number of system 
files. You can use any MS-DOS line editor, such as the EDIT command, to edit these files. 
For example:

c:\ edit config.sys
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Copy the RoamAbout Software
Copy the RoamAbout Software

The RoamAbout PC Card driver includes a small batch file (CPY2HDSK.BAT) that copies 
the RoamAbout software to the computer. 

To copy the RoamAbout software, perform the following steps:

1) To install the software on a computer that does not have a CD-ROM, or if you 
downloaded the software from the RoamAbout Wireless web site, copy the 
files to a floppy diskette.

2) Run the batch file CPY2HDSK.BAT with a chosen directory name.
For example: 

A:\cpy2hdsk C:\roamabt

Setup the WVLANCAD Program

The computer needs dedicated software that identifies the presence of a PC Card in the PC 
Card slot. For the RoamAbout PC Card, this can be one of the following:

• Card & Socket services software as provided by various software vendors.

• The WVLANCAD Card Access Driver (WVLANCAD.SYS).

The card software must be loaded before any other program (network driver or utility) tries 
to access the RoamAbout PC Card. 

This section describes the proper WVLANCAD installation procedure and settings for the 
following systems:

• Computers using Card & Socket Services

• Intel 82365 PCIC based computers

MEMORY ERRORS: It is possible that you may run out of DOS memory 
when installing the new wvlancad.sys driver. The new wvlancad.sys driver 
uses more conventional memory than the previous version. If you run into 
memory problems do not install the CAD and Socket Services.

NOTE
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Card & Socket Services
To ensure that WVLANCAD is always run at start-up time, perform the following:

1) Open (edit) the CONFIG.SYS system file. For example:

c:\ edit c:\config.sys

2) Add a DEVICE statement that identifies the path and filename of the 
WVLANCAD program. The format of the device line is 
as follows:

DEVICE = [path name]wvlancad.sys

Example:

DEVICE = c:\roamabt\wvlancad.sys

With Card & Socket Services, you do not need to set any parameters (Memory, IRQ, I/O 
Port) in the DEVICE statements. However, if you would like to override the default 
settings, follow the directions in Intel 82635 PCIC on page 8-4, using Table 8-1 on page 
8-5 to identify valid parameter values that can be included in the WVLANCAD.SYS 
DEVICE statement.

Intel 82635 PCIC

The RoamAbout PC Card access driver (WVLANCAD) must be started before any 
program (network driver or utility) can access the PC Card. To ensure that WVLANCAD 
always runs at start-up, edit the system file CONFIG.SYS to include a DEVICE statement 
that identifies the:

• Path and file name of the WVLANCAD program.

• Memory address of the RoamAbout PC Card.

• I/O port address of the RoamAbout PC Card.

• Interrupt request line number (IRQ) of the RoamAbout PC Card.

Use Table 8-1 on page 8-5 to identify valid parameter values that can be included in the 
DEVICE statement.

For your card to function properly, verify that the values you select to include in the 
DEVICE statement are not used by another device in the computer. Consult with your LAN 
administrator or a computer expert to determine an available memory address, I/O port 
address, and IRQ value that you can use to install the WVLANCAD driver.

Alternatively, you can use the Microsoft diagnostics program (MSD.EXE). For more 
information about this program, refer to the MS-DOS operating system documentation. 
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You can use any MS-DOS line editor to edit the CONFIG.SYS file. For example:

c:\ edit c:\config.sys

The format of the device line is as follows:

DEVICE = [path name]wvlancad.sys /m=xxxx /b=xxxx /i=nn

For example, if your device line is:

DEVICE = c:\roamabt\wvlancad.sys /m=d100 /b=0340 /i=11

The WVLANCAD is programmed to use:

• Memory address d100 - d1FF

• I/O port address ‘0340’H 

• IRQ 11

Table  8-1: WVLANCAD Configuration Parameter Values

Parameter Description Valid Values

<path> Disk drive and directory 
containing WVLANCAD.SYS (do 
not type the brackets)

/m=xxxx Memory address 4-digit hexadecimal value
Valid range: C000 - EF00 in increments of 
100 
For example:
C000, C100, C200, or C300.

/b=xxxx  I/O port address 4-digit hexadecimal value
Valid range: 0300 - FFC0 in increments of 40 
For example: 
0300, 0340, 0380, 03C0, 
FF00, FF40, FF80, or FFC0.

/i=nn  IRQ 1-digit or 2-digit decimal value
Valid values: 
3, 4, 5, 7, 9, 10, 11, 12, 14, or 15
 8-5



Install the Network Client Software
When you edit the CONFIG.SYS file, note the following:

• Remove any other PCMCIA-related DEVICE statement from the CONFIG.SYS file. 
For example, you must remove any DEVICE statements for Card Services or Socket 
Services. Consult the documentation that came with your computer or other PCMCIA 
device to help you to identify these statements.

• If your computer has a memory manager program installed such as EMM386.EXE, 
exclude the memory address space that you assigned to the WVLANCAD program. 
To exclude the memory space address, add an exclude parameter to the DEVICE 
statement that activates the memory manager program.

For example, if your computer uses the EMM386.EXE memory manager program, 
your DEVICE statement is:

DEVICE=c:\dos\emm386.exe noems x=d100-d1ff

• If using Microsoft Windows 3.x, use an ASCII text editor such as Notepad to edit the 
Windows SYSTEM.INI file to protect the memory address space assigned to the 
WVLANCAD program. For example, add the following statement to section 386Enh. 

= [386Enh] ... EMMExclude=D100-D1FF 

Install the Network Client Software

To use the RoamAbout PC Card in a network environment, you need to install network 
client software. If you have network client software installed, you should remove this 
software and run the network client installation program again.

1) Make the directory that contains the network client software the active 
directory.

For example, if you install the network client software from the A drive:

Make the A drive the active drive. For example:  C:\A:

2) Follow the directions in the network client software documentation to start 
the installation.

3) When prompted to select a driver, use Other Driver. This option could also 
be referred to as Updated or OEM driver, or driver provided by other 
vendor.

4) Remove the network client software disk from the diskette drive and insert 
the diskette with the driver software.

5) Follow the instructions that appear on your screen.
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Setup the RoamAbout Parameters

To connect your RoamAbout PC Card to a RoamAbout network system, you must 
configure the parameters to match the values of the network. These values should match 
the values set for the RoamAbout Access Points, or as agreed upon by the ad-hoc network 
participants.

This section describes how to set the parameters for the following RoamAbout drivers:

• RoamAbout DOS ODI Driver

• RoamAbout Packet Driver

DOS ODI Driver Configuration

When you are installing the network client software for Novell NetWare, the installation 
program prompts you to enter the RoamAbout parameters and save your parameter settings 
in the Novell network configuration file, NET.CFG.

If your network client software did not prompt you to enter the parameters or if you want 
to modify the RoamAbout parameter settings, you may need to edit the NET.CFG file 
manually as described in the About the NET.CFG File on page 8-11.

Table 8-2 lists the various RoamAbout parameters and their value ranges and usage.

Table  8-2: RoamAbout DOS ODI Driver Parameter Values

Parameter Description

Wireless_Network_Name Alphanumeric string that identifies the network to which you want 
to connect your computer.
Valid values: Up to 32 printable characters (spaces allowed) where:

• Enter the name between “double-quote marks”; otherwise, the 
name is converted to UPPER-CASE characters. The wireless 
network name is case sensitive.

• To connect to a specific network, the wireless network name 
must match the value set in the Access Points in the network.

• The value, ANY, enables your client to connect to any IEEE 
802.11 network. However, if the Access Point has Secure 
Access enabled, you must enter the wireless network name to 
connect to the Access Point.
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Station_Name Alphanumeric string that identifies your computer on the network. 
Also used by the RoamAbout Client Utility.
Valid values: Up to 32 printable characters (spaces allowed).
Enter the name between “double-quote marks”; otherwise, the name
is converted to UPPER-CASE characters.

PortType Parameter that determines whether the PC Card connects to a 
wireless infrastructure network (with an Access Point) or an ad-hoc
network (peer-to-peer network). 
Valid values:

• 1 - Connect to a wireless infrastructure network

• 3 - Connect to an ad-hoc network
Refer to the RoamAbout 802.11 Wireless Networking Guide for 
information on wireless network configurations.

AP_Density Parameter that controls the roaming sensitivity of your client (must 
be the same as the Access Point). 
Valid Values:

• 1 - Low Density (default)

• 2 - Medium Density

• 3 - High Density

Transmit_Rate1 Controls the rate at which the PC Card transmits its data.
Valid values:

• 1 - 1 Mbit

• 2 - 2 Mbit Fixed 

• 3 - Auto Rate, highest rate supported by card (default)

• 4 - 5.5 Mbit Fixed 

• 5 - 11 Mbit Fixed

• 6 - 2 Mbit Auto Rate

• 7 - 5.5 Mbit Auto Rate
See the RoamAbout 802.11 Wireless Networking Guide for more 
information.

Node_Address To be used only when your network system requires local MAC 
addressing.
Valid values:

• None - Uses the card’s factory installed universal MAC address
(default).

• 12 hexadecimal digits that identify the user-defined local MAC 
address. The second digit of the first digit-pair must be 2, 6, A, 
or E.

Parameter Description
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Medium_Reservation Enables/disables the RTS/CTS mechanism.
Valid values:

• 2347 (default) - Disables medium reservation.

• Numeric value in the range of 0-2346 enables the RTS/CTS 
protocol and sets the frame length threshold from which the 
client should start using the RTS/CTS. Recommended value for 
the hidden station problem is 500. 

Refer to the RoamAbout 802.11 Wireless Networking Guide for 
more information.

Card_Power_Management Enables or disables Power Management.
Valid Values:

• Y - Enable Power Management
• N - Disable Power Management (default)
When enabling Power Management you also need to set the 
Maximum_Sleep_Duration and Receive_All_Multicasts 
parameters. When you disable Power Management, these two 
parameters are disabled as well.

Maximum_Sleep_Duration This parameter specifies the Listen Interval of the client’s Power 
Management scheme, which is the maximum time the client is 
allowed to spend consecutively in DOZE state. 
Valid Values: any numerical value in the range of 1-65535 (default 
value is 100). In nearly all cases, you should NOT change the defau
value.
If Card_Power_Management is disabled, this parameter is ignored

Receive_All_Multicasts This parameter specifies whether the client must receive all 
multicast frames when in Power Management mode.
Valid Values:

• Y - Receive all Multicasts (default)

• N - Do not receive all Multicasts
When this parameter is enabled, the RoamAbout client wakes up at 
regular intervals to receive the multicast frames. Although enabling 
this option may yield less optimal power savings, you are advised to 
leave this parameter enabled when using your computer in regular 
networking environments.
If Card_Power_Management is disabled, this parameter is ignored.

Enable_Encryption This parameter enables or disables Data Encryption.
Valid values:

• Y - Enable Encryption

• N - Disable Encryption (default)
For more information about this parameter, refer to the RoamAbout 
802.11 Wireless Networking Guide. 

Parameter Description
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Key1 This parameter specifies one of four possible keys for the Data 
encryption. All keys specified can be used for the deciphering of data 
that is received.
Valid values:

• 5 printable character string, or 10 hexadecimal digits preceded 
by 0x.

• 13 printable character string, or 26 hexadecimal digits preceded 
by 0x. (Only available with a RoamAbout PC Card that supports 
128-bit encryption.)

If this parameter is omitted, the default is no key. 
The keys defined in the client must match the keys defined in the 
Access Points. In addition the key in position 1 must match the key 
in position 1 on the Access Point. The keys in positions 2, 3, and 4 
must also match the keys in positions 2, 3, and 4 on the Access Point.

Key2 Same description as Key1.

Key3 Same description as Key1.

Key4 Same description as Key1.

Transmit_Key_ID Designates which key is used for enciphering the data transmitted by 
this client.
Valid values: 1, 2, 3, or 4. 

1 This parameter does not influence the data rate at which the client is able to receive data. For 
example, if the transmit rate is locked to 1 Mbit/s, the client may still receive messages that were 
transmitted at 2 Mbit/s.

Parameter Description
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About the NET.CFG File

The RoamAbout configuration parameters for the DOS ODI driver are stored in a network 
configuration file called NET.CFG. A sample of a NET.CFG file is included on the 
RoamAbout software diskette, and is identified as WVLAN43.CFG. 

If you installed the Novell network client software described earlier in this chapter, this file 
was created automatically. Proceed with Completing the Installation on page 8-18, 
unless you want to modify the RoamAbout parameter settings. 

A NET.CFG file must always include a Link Driver statement that refers to the appropriate 
network driver and a list of parameters and parameter values that apply to the referenced 
driver. 

For the RoamAbout driver, the NET.CFG file appears as follows:

LINK DRIVER WVLAN43

; BASIC PARAMETERS
WIRELESS_NETWORK_NAME XXXXXXXX
STATION_NAME XXXXXXXX

;ADVANCED PARAMETERS
; AP_DENSITY 1
; TRANSMIT_RATE 3
; MEDIUM_RESERVATION 2347
; NODE ADDRESS

All lines that start with a semi-colon (;) are informational comments to the user. The driver 
ignores these lines.

Table 8-2 on page 8-7 lists the various RoamAbout parameters with their value ranges and 
usage. 

If the installation program of your network client software did not prompt you to identify a 
driver or specify the RoamAbout parameters, you may need to identify the proper location 
of the RoamAbout DOS ODI driver and the NET.CFG file. This allows your network client 
software to find the correct driver.
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Copy the RoamAbout DOS ODI driver and the NET.CFG file to the same directory that 
you selected to install the network operating system software. For example, if you selected 
the directory, C:\NETWORK, use the following copy commands:

c:\
cd\roamabt\dosodi
copy wvlan43.com c:\network
copy net.cfg c:\network

1) Edit the NET.CFG file to add the statement:

2) Link Driver WVLAN43

3) Enter the RoamAbout parameter values on a new line, directly after the Link 
Driver statement.

4) When finished, save NET.CFG and restart your computer.

5) Proceed with the Completing the Installation on page 8-18.

Packet Driver Configuration

When installing the RoamAbout packet driver, you need to edit a number of system files. 
To ensure that the packet driver is loaded at start-up, add a few command line statements 
to the AUTOEXEC.BAT file. These statements should include:

• A path to the directory that contains the packet driver.

• A Load Driver statement.

The RoamAbout parameters are identified in a network configuration file called 
PACKET.INI. The packet driver and PACKET.INI must reside in the same directory. 
When you used the commands as identified in the Copy the RoamAbout Software on 
page 8-3, this directory is typically: 

c:\roamabt\packet

When modifying NET.CFG, ensure that all RoamAbout parameter lines are 
indented. Use the  key on your keyboard to create an indent at the 
beginning of each line that contains a RoamAbout parameter. 

NOTE TAB
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To set up the RoamAbout packet driver:

1) Edit the AUTOEXEC.BAT file of your computer to add the path and file 
name of the RoamAbout packet driver and the Load Driver statement:

cd\roamabt\packet
lh=wvlan42.com l

2) To set the RoamAbout parameters, edit the PACKET.INI file. The structure 
of the PACKET.INI file is:

BASIC PARAMETERS
WIRELESS_NETWORK_NAME XXXXXXXX
STATION_NAME XXXXXXXX
ADVANCED PARAMETERS

; AP_DENSITY 1
; TRANSMIT_RATE 3
; MEDIUM_RESERVATION 2347
; MAC ADDRESS

All lines that start with a semi-colon (;) are informational comments to the user. The 
driver ignores these lines.

The settings for the parameters depend on the configuration of the wireless network.

3) To set a parameter value, remove the semi-colon (;) preceding the parameter 
name and enter a value within the range as specified in Table 8-3 on page 
8-14. 

At the end of the PACKET.INI file is an additional set of generic packet driver param-
eters that are not directly related to RoamAbout operation.

; DRIVER_CLASS 1
; NOVELL_FLAG NO
; PACKET_INTERRUPT 60

4) Consult your LAN administrator to select the appropriate values that apply in 
your situation from the range specified in Table 8-4 on page 8-18.

5) When finished, save the PACKET.INI file and restart your computer.

6) Proceed with the Completing the Installation on page 8-18.

If PACKET.INI contains an unknown keyword, the packet driver displays an 
error message and loads anyway. If PACKET.INI has a configuration 
parameter with an invalid value, the packet driver displays an error 
message but does not load.

NOTE
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Table  8-3: RoamAbout Packet Driver Parameter Values

Parameter Description 

Wireless_Network_Name Alphanumeric string that identifies the network to which you 
would like to connect your client.
Valid values: Up to 32 printable characters (spaces allowed) 
where:

• Enter the name between “double-quote marks”; otherwise, 
the name is converted to UPPER-CASE characters. The 
Wireless Network Name is case sensitive.

• To connect to a specific network only, the Wireless 
Network Name must match the value set in the RoamAbout 
Access Points in the network.

• The value, ANY, enables your client to connect to any 
IEEE 802.11 network. However, if the RoamAbout Access 
Point has Secure Access enabled, you must enter the 
wireless network name to connect to the wireless network.

Station_Name Alphanumeric string that identifies your computer on the 
network, also used by the RoamAbout Client Utility.
Valid values: Up to 32 printable characters (spaces allowed).

Port_Type Parameter that determines whether the PC Card connects to a 
wireless infrastructure network (with an Access Point) or an ad-
hoc network (peer-to-peer network). 
Valid values:

• 1 - Connect to a wireless infrastructure network

• 3 - Connect to an ad-hoc network
Refer to the RoamAbout 802.11 Wireless Networking Guide for 
information on wireless network configurations.

AP_Density Parameter that controls the roaming sensitivity of your 
computer (must be the same as the Access Point).
Valid values:

• 1 - Low density (default)

• 2 - Medium density

• 3 - High density
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Parameter Description 

Transmit_Rate1 Controls the data rate at which your RoamAbout PC Card 
transmits its data.
Valid values:

• 1 - 1 Mbit

• 2 - 2 Mbit Fixed 

• 3 - Auto Rate, highest rate supported by card (default)

• 4 - 5.5 Mbit Fixed 

• 5 - 11 Mbit Fixed

• 6 - 2 Mbit Auto Rate

• 7 - 5.5 Mbit Auto Rate
See the RoamAbout 802.11 Wireless Networking Guide for 
more information.

MAC_Address To be used only when your network system requires local MAC 
addressing.
Valid values:

• None - Uses the card’s factory installed universal MAC 
address (default).

• 12 hexadecimal digits that identify the user-defined local 
MAC address. The second digit of the first digit-pair must 
be 2, 6, A, or E.

Medium_
Reservation

Enables/disables the RTS/CTS mechanism. 

Valid values:

2347 (default)
Disables medium reservation.

Numeric value in the range of 0-2346 
Enables the RTS/CTS mechanism, and sets the frame 
length threshold from which the client should start using 
the RTS/CTS mechanism. (Recommended value or the 
hidden station problem is 500.)

See the RoamAbout 802.11 Wireless Networking Guide 
for more information.
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Setup the RoamAbout Parameters
Parameter Description 

Card_Power_Management Enables or disables Power Management.
Valid Values:

• Y - Yes, enable Power Management
• N - No, disable Power Management (default)
When enabling Power Management you also need to set the 
Maximum_Sleep_Duration and Receive_All_Multicasts 
parameters.
When you disable Power Management, these two parameters 
are disabled as well.

Maximum_Sleep_Duration This parameter specifies the maximum time the client is 
allowed to spend consecutively in DOZE state. 
Valid Values: any numerical value in the range of 1-65535 
(default is 100). In nearly all cases, you should NOT change the 
default value.
This parameter determines the Listen Interval of the client’s 
Power Management scheme.
If Card_Power_Management is disabled, this parameter is 
ignored.

Receive_All_Multicasts This parameter specifies whether the client must receive all 
multicast frames when in Power Management mode.
Valid Values:

• Y - Receive all Multicasts (default)

• N - Do not receive all Multicasts
When this parameter is enabled, the RoamAbout client wakes 
up at regular intervals to receive the multicast frames. Although 
enabling this option may yield less optimal power savings, you 
are advised to leave this parameter enabled when using your 
computer in regular networking environments.
If Card_Power_Management is disabled, this parameter is 
ignored.

Enable_Encryption This parameter enables or disables Data Encryption.
Valid values:

• Y - Enable Encryption

• N - Disable Encryption (default)
For more information about this parameter, refer to the 
RoamAbout 802.11 Wireless Networking Guide. 
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For more information about each of the RoamAbout parameters:

• Consult the description for the RoamAbout parameters as described in the RoamAbout 
802.11 Wireless Networking Guide.

• Type the following command lines at the MS-DOS prompt to display help for the 
RoamAbout packet driver.

cd\roamabt\packet
wvlan42.com h

Parameter Description 

Key1 This parameter specifies one of 4 possible keys for the Data 
encryption. All keys specified can be used for the deciphering 
of data that is received.
Valid values:

• 5 printable character string, or 10 hexadecimal digits 
preceded by 0x.

• 13 printable character string, or 26 hexadecimal digits 
preceded by 0x. (Only available with a RoamAbout PC 
Card that supports 128-bit encryption.)

If this parameter is omitted, the default is no key. 
The keys defined in the client must match the keys defined in 
the Access Points. In addition the key in position 1 must match 
the key in position 1 on the Access Point. The keys in positions 
2, 3, and 4 must also match the keys in positions 2, 3, and 4 on 
the Access Point.

Key2 Same description as Key1.

Key3 Same description as Key1.

Key4 Same description as Key1.

Transmit_Key_ID Designates which key is to be used for enciphering the data that 
is transmitted by this client.
Valid values: 1, 2, 3, or 4. 

1 This parameter does not influence the data rate at which the client is able to receive data. For 
example, if the transmit rate is ‘locked’ to 1 Mbit/s, the client may still receive messages that were 
transmitted at 2 Mbit/s.
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Completing the Installation
Table  8-4: Packet Driver Specific Parameters

Completing the Installation

To finish the installation, insert the RoamAbout PC Card and restart the computer. 
Carefully read the messages that appear on the screen to verify that:

• The WVLANCAD program executes correctly.

• Your computer loads the correct driver parameter settings of the PC Card.

Correct execution of the WVLANCAD program is confirmed with a message, such as:

IEEE Card Access Driver, Variant X, Version XX.XX
Memory: xxxx, I/O Base: xxxx, IRQ xx
Card Access Driver Installed

Where:

• XX.XX identifies the version of the RoamAbout PC Card access driver.

• xx or xxx identifies the values that you entered upon installation of the WVLANCAD 
software, as described in the Intel 82635 PCIC on page 8-4.

Parameter Description

Driver_Class A specific packet driver parameter that controls the frame format.

Valid values:

• 1 - DIX Ethernet (v2.0) frame format (default)

• 11 - IEEE 802.3 with 802.2 headers frame format

Novell_Flag Enables support for the Novell IPX 802.3 frame format.

Valid values:

• Y - Convert all 802.3 type packets to 8137 type packets

• N - Do not use the NovellFlag (default)

Packet_Interrupt This parameter identifies the software interrupt number that the 
packet driver should use. 

Valid values (hexadecimal):

• 60 (default)

• 70
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Completing the Installation
A successful load of the DOS ODI driver is confirmed with the following message:

IEEE DOS ODI Driver Variant X, v0.0x (yymmdd)
Desired SSID = AAAAAAAAAA
Driver loaded successfully
IRQ xx, Port xxxx, Node Address = xxxxxxxxxxxx L
Max Frame 1514 bytes, Line Speed 2 Mbps, Bus ID 3
Board 1, Frame ETHERNET_802.2, LSB Mode

Where:

• AAAAAAAAA identifies the wireless network name entered in the NET.CFG file.

• xx or xxx identifies the values that you entered upon installation of the WVLANCAD 
software, as described in the Intel 82635 PCIC on page 8-4.

A successful load of the packet driver is confirmed with the following message:

IEEE Packet Driver, Variant X, Version X.XX
Novell Flag NOT set
IO Base=xxxx IRQ=xx MAC Address=xxxxxxxxxxxx 
Packet Interrupt=0xXX

Where:

• Version X.XX identifies the version of the RoamAbout packet driver.

• xx or xxx identifies the values that you entered upon installation of the WVLANCAD 
software as described in the Intel 82635 PCIC on page 8-4.

• Packet Interrupt 0xXX identifies the value you specified in the PACKET.INI file.
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Advanced Options
Advanced Options

Dual Card Configuration

When you intend to use multiple RoamAbout PC Cards in a single computing device, such 
as a wireless server, the CONFIG.SYS file should contain a DEVICE statement with 
unique parameter values for each card. For example:

DEVICE = c:\roamabt\wvlancad.sys /m=d100 /b=0340 /i=11
DEVICE = c:\roamabt\wvlancad.sys /m=e300 /b=04C0 /i=14

Start-Up Menu Configuration

When you intend to use your computer in combination with multiple PC Cards, an 
MS-DOS start-up menu may provide a useful solution in one or more of the following 
situations:

• You are using your computer in combination with another PC Card that requires Card 
and Socket Services.

• You want to use your computer with a RoamAbout PC Card or Ethernet adapter card.

The start-up menu enables you to set up the computer to prompt the computer user to select 
a specific configuration. Subject to the selected menu option, the computer automatically 
loads the drivers and programs required for each specific option. 

The start-up menu is a standard MS-DOS feature that is described in the Microsoft 
MS-DOS User’s Guide. 

When using multiple boot options to swap RoamAbout PC Cards with 
Ethernet adapters and vice versa, you need to install the network client 
software twice, selecting separate directories for each of the network client 
configurations. The start-up menu should identify which network 
configuration file is loaded for each item subject to the selected menu item. 
Failing to do so results in the network client install programs overwriting 
the configuration settings of the card you installed first.

NOTE
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Chapter 9

Macintosh Driver

This chapter provides setup and installation information for the Macintosh Driver V4.02 to 
support the RoamAbout DS PC card in an 802.11 wireless LAN. This driver works with 
various versions of the RoamAbout PC Card. However, earlier versions of the RoamAbout 
PC Card do not support WEP and cannot be upgraded to support encryption. The 
Determining if your Card Supports Encryption provides the instructions to determine 
whether or not your PC Card supports encryption.

To install the RoamAbout driver, you should have a working knowledge of Macintosh 
operations and a working knowledge of installing network adapter cards and network client 
software.

In This Chapter

Section Page

System Requirements 9-2

Determining if your Card Supports Encryption 9-2

Remove Previously Installed Driver 9-2

Driver Installation and Configuration 9-3
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System Requirements
System Requirements
• PowerBook 2400, 3400, or G3 running System 7.6.1 or later with Open Transport 

V1.1.2 or later. On these systems, the driver is not compatible with earlier Macintosh 
system software.

• PowerBook 1400 or 5300 running System 7.5.3 or later with Open Transport V1.1.2 
or later. On these systems, the driver is not compatible with Apple Classic

• PowerBook 190 System 7.5.2 or later with Open Transport (V1.1.2 or later) or Apple 
Classic.

Determining if your Card Supports Encryption
To determine if the RoamAbout PC Card supports encryption, check for a sticker on the 
back of the PC Card that states support for 40-bit or 128-bit encryption.

Remove Previously Installed Driver
You must remove a previously installed driver when you:

• Upgrade a driver

• Change the type of driver

For example, you would change the type of driver when migrating from Apple Classic to 
Apple Open Transport.

To remove the driver, proceed as follows:

1) Insert the RoamAbout Drivers and Utilities CD-ROM into your Apple 
PowerBook. Or, if you downloaded the driver from the RoamAbout Wireless 
web site, go to the directory where you downloaded the driver.

2) If you are installing the files from the CD-ROM, double-click on the 
CD-ROM icon on the desktop of your computer to display the contents of the 
CD-ROM. 

or

To install the PC Card in an Apple PowerBook system, the system must have 
a PC Card slotNOTE
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Driver Installation and Configuration
If you downloaded the driver from the RoamAbout Wireless web site, 
double-click on the directory where you downloaded the driver to display the 
contents. 

3) Double-click on the ARA40200.hqx file to unstuff the files.

4) Double-click on the RoamAbout Installer to start the installation program.

5) In the Welcome window, click Continue.

6) From the list of options, select Custom Remove.

7) Click all boxes to completely remove the driver. If you have any open 
applications, you are prompted to close them.

8) Follow the on-line instructions.

9) When completed, restart your computer.

Driver Installation and Configuration
Before you install the driver, install and enable the network protocols (Apple’s Open 
Transport or Apple Classic), and remove any previously installed wireless networking 
software.

1) If this is an upgrade, remove the previously installed driver. Go to the 
Remove Previously Installed Driver section in this document.

2) Insert the RoamAbout Drivers and Utilities CD-ROM into your Apple 
PowerBook. Or, if you downloaded the driver from the RoamAbout Wireless 
web site, go to the directory where you downloaded the driver.

3) Double-click on the ARA40200.hqx file to unstuff the files.

4) Double-click on RoamAbout Installer to start. 

5) Click Continue in the Welcome window to proceed.

6) In the list of options, select the option for your computer as follows. 
Typically, you should select Easy Install.

For PowerBook 2400, 3400, or G3 running System 7.6.1 or later, Easy Install 
chooses RoamAbout PC Card Networking Software (PCI).

For PowerBook 1400 or 5300 running System 7.5.3 or later, Easy Install 
chooses RoamAbout PC Card Networking Software (PPC). Use Custom 
Install to choose RoamAbout PC Card Networking Software (68K) for 
Apple Classic compatibility.
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Driver Installation and Configuration
For PowerBook 190 running System 7.5.2 or later, Easy Install chooses 
RoamAbout PC Card Networking Software (68K).

7) Restart the computer when prompted. After the restart, close any unnecessary 
windows.

8) Insert the PC Card (logo side up) into the PC Card slot. The RoamAbout 
802.11 DS icon is displayed. For PowerBook 3400 and G3 systems, use the 
lower PC Card slot. The upper slot sometimes fails to properly recognize the 
PC Card, which may cause unreliable operation.

9) Open the Apple Menu, select Control Panels then AppleTalk.

10) In the AppleTalk window, select RoamAbout 802.11 DS (if it is not present, 
select Ethernet) from the Connect Via list.

11) Close the AppleTalk window. Click Save to confirm the changes.

12) Open the Apple menu, select Control Panels then select RoamAbout Setup.

13) Enter the wireless network name in the RoamAbout Network field if joining 
an infrastructure network. The wireless network name is case sensitive.

14) When done, restart your computer.

You may need to set other parameters depending on your wireless network configuration. 
See the Read Me file or the RoamAbout 802.11 Wireless Networking Guide for more 
information. Otherwise, click OK and restart the computer when prompted.
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Appendix A

RoamAbout Client Utility

The RoamAbout Client Utility V6.0 is a management tool that you can use to verify the 
quality of your wireless radio connection to the RoamAbout network. The Client Utility can 
be installed on any computer running Microsoft Windows 95, 98, 2000, NT, or Millennium. 

Use the RoamAbout Client Utility to:

• Check the quality of wireless communications between the RoamAbout client and the 
associated Access Point (or another client in an ad-hoc network).

• Check the communications quality between the client and all other Access Points 
(within radio range) in the wireless infrastructure network. This test allows you to 
optimize placement of the RoamAbout client and Access Points.

• Display information about the configuration settings of the RoamAbout client and the 
Access Point.

• Perform a diagnostic test on the RoamAbout PC Card.

• Check the version numbers of the RoamAbout components installed in the client.

• Store test results in log files.

In this Appendix
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Installing the Client Utility
Installing the Client Utility

The Client Utility shipped with the RoamAbout driver might not fully work for previous 
generation RoamAbout drivers. You should always use the Client Utility that was shipped 
with the RoamAbout driver. The Client Utility installation is managed through an 
installation wizard.

After you install the RoamAbout driver, install the RoamAbout Client Utility by 
performing the following steps:

1) Start the installation procedure by double-clicking on the setup executable 
file:

• On your RoamAbout CD-ROM in the Client Utility under the selected 
driver folder.

• If you downloaded an update from the RoamAbout Wireless web site, in the 
directory you specified during the download.

2) The installation wizard automatically install the program files in the 
following directory on the hard disk of your computer:

C:\Program Files\RoamAbout\Client
 

The following files are installed in the specified directory:

• CMRBT.exe (Client Utility executable)

• CMRBT.hlp (Client Utility Help information(

• CMRBT.cnt (Client Utility Help Contents)

3) Reboot your computer.

Remove the Client Utility Icon from the 
Windows Task bar

A-8

Uninstall the Client Utility A-9

Optionally, you may choose to select another folder or hard disk for the 
installation.

Section Page

NOTE
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Start the RoamAbout Client Utility
Start the RoamAbout Client Utility

To start the RoamAbout Client Utility, perform the following:

• Click on the Client Utility icon , located on the System Tray of your Windows 
Task bar.
or

• From the Windows Task bar, click Start, then select 
Programs→RoamAbout→Client Utility.

The RoamAbout Client Utility main window, shown in Figure 9-1, displays the following 
information:

• If connected to an infrastructure network, the name of the network.

• The quality of the communications with the selected network as indicated by a Green 
(Good), Yellow (Adequate) or Red (Poor) indicator.

• Error message if the PC Card is not functioning properly.

Figure  9-1: RoamAbout Client Utility Main Window
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You can perform the following tasks from the RoamAbout Client Utility main window:

• Select another user-defined configuration profile

• Add or Edit a user-defined configuration profile 

• Diagnose the performance of your wireless PC Card by using one of the options under 
the Advanced menu.

— Perform a PC Card hardware test running the Card Diagnostics. The Card 
Diagnostics option verifies your hardware and can help determine the cause
malfunctioning card. The Card Diagnostics option is Card Check.

— Perform a radio Link Test with a single Access Point or computer. The Link T
option allows you to verify the communications quality of the RoamAbout PC
Card in more detail. It allows you to investigate the performance of the 
RoamAbout radio link between:

o Your computer and another wireless computer.

o Your computer and the current Access Point.

— Perform a Site Survey using the Site Monitor option. The Site Monitor option
allows you to display the communications quality of your computer with multip
Access Points in its vicinity. The Site Monitor option allows you to conduct a s
survey to

o Determine the overall wireless coverage of your LAN network.

o Determine or optimize the placement of your Access Points, to provide
seamless connectivity to mobile stations.

For detailed information about each Client Utility window, consult the RoamAbout Cli
Utility on-line help by clicking the Help button in each window, or pressing the <F1> key. 

If the wireless network uses encryption and the client does not, the initial 
client utility window could show a valid network connection. However, the 
client might not be able to exchange data with the network.

NOTE
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Card Diagnostics
Card Diagnostics

Use the Card Diagnostics window to investigate the operation of your RoamAbout PC Card 
and the installed driver. Click on the Test Card Now button to perform the card 
diagnostics. The results of the card diagnostics are listed under the self test fields.

Click on the Generate Report button to create a log file of the wireless network card 
components and system settings of your computer. If you need to contact RoamAbout 
technical support, the card test results may help the support representative determine the 
cause of a malfunctioning device. 

Running the Card Test may disrupt normal operation of the RoamAbout PC 
Card. This may result in a loss of your current connection to your network. 
When you click the ’Test Card Now’ button, the RoamAbout Client Utility 
displays a warning that allows you to either abort or proceed with the Card 
Test.

!
CAUTION
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Link Test
Link Test 

Use the RoamAbout Client Utility Link Test window (Figure 9-2) to investigate the 
specific link between the RoamAbout client and its test partner. If connected to a 
infrastructure network, the test partner is the associated Access Point. If configured for an 
ad-hoc network, you can select another client in the network to be the test partner.

To monitor the communications quality of the client connection to the network, Link Test 
actively exchanges test messages with the test partner. 

When you run the Link Test while roaming through a network environment with multiple 
Access Points, the link test partner (Access Point) changes as you move from cell to cell. 

Figure  9-2: RoamAbout Client Utility Link Test 
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Site Monitor
Site Monitor

Use the RoamAbout Client Utility Site Monitor window, shown in Figure 9-3, to monitor 
the radio communications quality with multiple RoamAbout Access Points simultaneously.

The Site Monitor window only displays the Access Points within range of the client. If the 
Site Monitor window does not display all the Access Points that you expect, the unlisted 
Access Point might be out of range of your client or using another wireless network name.

The Site Monitor window offers a set of pull-down menus that enable you to display and 
organize diagnostic information according to your preferences. The Site Monitor function 
also allows you to save measurement data to a log file.

Figure  9-3: RoamAbout Client Utility Site Monitor Window
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Close the Client Utility
Close the Client Utility

To close the Client Utility, perform the following steps:

1) Use the right-mouse button to click on the Client Utility icon in System Tray 
of your Windows task bar.

2) From the pop-up menu select Exit. 

When you restart your computer, the Client Utility icon reappears automatically on the 
Task bar. 

Remove the Client Utility Icon from the Windows Task 
bar

If you do not want the Client Utility icon to appear on your Windows Task bar every time 
you power up your computer, perform the following steps:

1) From the Windows Task bar, click Start, then select Settings-->Task bar.

2) Click on the Start Menu tab.

3) Click on the Remove button. The Remove Shortcuts/Folders window 
appears.

4) Scroll down the list of items and double-click on Startup.

5) Select Client Utility and click the Remove button. The program removes the 
icon form your start-up program.

6) Click on the Close button to return to the Task bar Properties window.

7) Click on the OK button to exit. 
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Uninstall the Client Utility
Uninstall the Client Utility

To uninstall the Client Utility program from your computer, perform the following steps:

1) Close the Client Manager. Right-click on the Client Utility icon and select 
Exit.

2) From the Windows Task bar, click Start, then select 
Settings-->Control Panel.

3) Double-click on the Add/Remove Programs icon.

4) Scroll down the list of items and select RoamAbout Client Utility. 

5) Click on the Add/Remove button to uninstall the Client Utility software from 
your computer.
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Appendix B

RoamAbout WSU

The RoamAbout WSU V6.06 tool updates the firmware (also called embedded software) 
of your RoamAbout 802.11 PC Cards. The firmware is included in the tool 
(wsu10606.exe). Double-click on the wsu10606.exe. Refer to the online help for more 
information.

Both the Primary functions and the Station functions can be updated. The firmware itself is 
already included in the tool (wsu.exe).

When you launch the WSU tool, it performs a test to verify the following:

• Hardware version of your RoamAbout PC Card.

• Current firmware version of the card.

• Compatibility of the current Miniport driver with the new firmware.

Once completed, the WSU displays a summary of this information in the Main screen of 
the tool.

IMPORTANT:

• The new Miniport Drivers require the station firmware on the RoamAbout 802.11 PC 
Card Version 6.04, or higher. 

• This firmware update requires the RoamAbout Miniport driver Version 6.25. Upgrade 
the driver before you upgrade the station firmware. 

In this Appendix
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Operating System Requirements
Operating System Requirements

The WSU tool is a Microsoft Windows based tool that requires one of the following 
Microsoft operating systems on the computer that you want to use for upgrading your 
RoamAbout PC Cards: 

• Microsoft Windows 95

• Microsoft Windows 98

• Microsoft Windows NT V4.0

• Microsoft Windows 2000

• Microsoft Millennium

Station Requirements

The WSU tool runs on any desktop or laptop computer equipped that meets the following 
requirements:

• A supported Microsoft Windows operating system 

• Equipped with a PC Card slot to insert the RoamAbout PC Card that you want to 
update.

• A 32-bit RoamAbout 802.11 DS Miniport Driver installed.

When the RoamAbout 802.11 PC Cards are used in an Apple MAC OS, 
MS-DOS, or WinCE system/device, you need a station with one of the 
supported Microsoft Windows operating systems listed above to update the 
cards.

When the RoamAbout 802.11 PC Cards are used in an Apple MAC OS, 
MS-DOS, or WinCE system/device, you need a station with one of the 
supported Microsoft Windows operating systems listed in the Operating 
System Requirements section.

NOTE

NOTE
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Upgrading the PC Card Firmware
Upgrading the PC Card Firmware

To allow a successful update, you may need to install a newer version of the RoamAbout 
802.11 DS Miniport driver on the station that runs the WSU tool.

To copy and use the WSU, perform the following: 
1) Ensure that the PC card is installed, and that the driver is operational.

2) Copy the WSU folder onto a hard drive.

3) Double-click on the wsu10606.exe. 

4) Click on the Details button to display the version information of all of the 
RoamAbout components. This option is also useful when contacting 
RoamAbout Technical Support.

5) If all of the items listed are compatible, click on the Update button.

• When you are trying to load firmware older than the card’s current 
version, the WSU tool prompts you to confirm the downgrade.

• When you are trying to load firmware that is not compatible with the 
RoamAbout 802.11 DS Miniport installed on your computer, the WSU 
tool displays a warning message. 

When the card update is completed successfully, don’t forget to update the 
RoamAbout driver on the computer that you want to use in combination with 
the updated card.

NOTE
RoamAbout WSU B-3




	Notice
	Preface
	1 Windows 95 Driver
	2 Windows 98 Driver
	3 Windows 2000 Driver
	4 Windows Millennium Driver
	5 Windows NT Driver
	6 Windows CE Driver
	7 Linux Driver
	8 MS-DOS and Workgroup for Windows Driver
	9 Macintosh Driver
	A RoamAbout Client Utility
	B RoamAbout WSU


	Preface
	Intended Audience
	Organization
	Associated Documents
	Getting Help

	Windows 95 Driver
	In This Chapter
	System Requirements
	Determining if your Card Supports Encryption
	Upgrading the Driver
	Removing the RoamAbout Miniport Driver Version prior to 6.25
	Deleting the RoamAbout Driver Files

	New Installations
	Reinstallation
	Installation Verification
	Driver Configuration

	Windows 98 Driver
	In This Chapter
	System Requirements
	Determining if your Card Supports Encryption
	New Installations
	Reinstallation
	Installation Verification
	Driver Configuration

	Windows 2000 Driver
	In This Chapter
	System Requirements
	Determining if your Card Supports Encryption
	Installation
	Installation Verification
	Driver Configuration

	Windows Millennium Driver
	In This Chapter
	System Requirements
	Determining if your Card Supports Encryption
	New Installations
	Reinstallation or Upgrade
	Installation Verification
	Driver Configuration

	Windows NT Driver
	In This Chapter
	System Requirements
	Determining if your Card Supports Encryption
	Windows NT System Configuration for New Driver Installation
	New Installations
	Reinstallation or Upgrade
	Installation Verification
	Driver Configuration

	Windows CE Driver
	In This Chapter
	System Requirements
	Pre-installation Requirements
	Installation
	Driver Configuration

	Linux Driver
	In This Chapter
	Operating System Support
	Distribution Kit Contents
	Installation Overview
	How to Configure PCMCIA Services on your Computer
	How to Mount and Extract the RoamAbout 802.11 DS Binary Distribution
	How to Configure the RoamAbout DS PC Card
	Per-Distribution Configuration Notes
	Red Hat 6.2
	SuSE 6.4

	How to Change Kernels and Work with Distribution without Binary Support
	How to Manually Configure the Driver Parameters
	RoamAbout DS PC Card Parameter Information
	Troubleshooting

	MS-DOS and Workgroup for Windows Driver
	In This Chapter
	Driver Types
	Installation Overview
	Copy the RoamAbout Software
	Setup the WVLANCAD Program
	Card & Socket Services
	Intel 82635 PCIC

	Install the Network Client Software
	Setup the RoamAbout Parameters
	DOS ODI Driver Configuration
	About the NET.CFG File
	Packet Driver Configuration

	Completing the Installation
	Advanced Options
	Dual Card Configuration
	Start-Up Menu Configuration


	Macintosh Driver
	In This Chapter
	System Requirements
	Determining if your Card Supports Encryption
	Remove Previously Installed Driver
	Driver Installation and Configuration

	RoamAbout Client Utility
	In this Appendix
	Installing the Client Utility
	Start the RoamAbout Client Utility
	Card Diagnostics
	Link Test
	Site Monitor
	Close the Client Utility
	Remove the Client Utility Icon from the Windows Task bar
	Uninstall the Client Utility

	RoamAbout WSU
	In this Appendix
	Operating System Requirements
	Station Requirements
	Upgrading the PC Card Firmware


